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Let us remember: 
Basic components of a computer system
1. Central processing unit (number of processor cores) – clock speed, cache memory, speed.
2. Operating memory (RAM) – size, speed.
3. Memory storage – HDD, SSD – size, speed – write speed and read speed.
4. Graphics (video) card – built into the motherboard or standalone module, speed, memory, 

etc.

1. What is a supercomputer?
A computer whose characteristics at the time of its creation are many times better than the 

characteristics of general-purpose computers is called a supercomputer. Particular attention is paid 
to data processing capacity or the speed at which the computer performs calculations.

Supercomputers are used to solve problems that require a huge number of calculations per 
second. The areas in which they are used can be (but not only):

• Problems in quantum mechanics.
• Weather forecasts and climate research.
• Chemistry - modeling of properties and structures of chemical compounds, polymers and 

crystals.
• Biology - biological macromolecules.
• Cryptanalysis.
• Physics – creation of physical simulations (tests of various technical devices such as 

airplanes, e.g., in wind tunnels, etc.) nuclear fusion, in CERN, etc.
• For military purposes – detonation of nuclear weapons, testing of military equipment in 

various conditions.

Fig. 1. Supercomputer
Supercomputers are mainly used by worldwide universities, scientific and military 

organizations.

1. superComputers

I. Computer systems
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2. History
In the 1960s, the Atlas is the third supercomputer project at the University of Manchester.
This is followed by a series of computers in the Control Data Corporation (CDC) that use 

innovative design and parallel data processing to achieve superior computing performance.

Fig. 2. Atlas
Atlas is a joint project of Ferranti – a British electrical engineering company, and the 

University of Manchester and is designed to run at processing speeds approaching one microsecond 
per instruction or about one million instructions per second. Construction of the first “Atlas” 
officially began on December 7, 1962 as one of the first supercomputers in the world considered 
the most powerful computers in the world at that time.

3. Supercomputers in Bulgaria
In the 1970s and 1980s, the production of computers in Bulgaria developed rapidly. At that 

time, the computer IZOT 1014 E was designed and created, which had a capacity of 100 million 
operations per second.

In 2008, Bulgaria enters position 126 in the ranking with its first supercomputer Blue Gene, 
located in the National Center for Supercomputer Applications. As of November 2009, it is ranked 
377th, and by November 2012, it is already out of the top 500 in terms of productivity.

Fig. 3. IZOT
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Since July 2016, the NESTUM cluster has been operating in Sofia Tech Park, based on a 
compact homogeneous PC architecture with a total of 768 processor cores, each with 4 GB of 
RAM (3 TB in total), with a theoretical computing capacity of 23,347 GFlops.

4. Performance measurement
The measure of computer performance is called flops (FLoating point Operations Per 

Second) – the number of floating point operations that a computer can perform in one second. 
The FLOPS unit is similar to the IPS (or MIPS), which shows the number of instructions 

per second executed by a processor. The two terms are similar, but with different meanings, 
because different instructions take different amounts of time, so the number of instructions that 
the processor executes per second depends on the specific type of instructions. In particular, the 
performance of a processor in MFLOPS may be less or greater than that in MIPS, depending on 
the specific type of calculation, resp. instructions with which the measurement was performed.

The barrier of 1 PFLOPS (petaFLOPS) was first crossed by the Jaguar supercomputer in 
2008.

The following table shows the derivatives of FLOPS units and the year in which the respective 
barrier was first jumped by a supercomputer:

Glossary
Supercomputer – a computer whose characteristics at the time of its creation are many 

times better than the characteristics of general-purpose computers.
Cluster – a group of computers, united by a high-speed connection and representing from 

the point of view of the user a single resource; /e.g., several processor cores combined and working 
as one processor.

A floating-point number is a form of representation of real numbers in which the number is 
represented in an exponential notation as an ordered pair composed of the base and the exponent.

Questions:
1. Which are the main characteristics of a computer system?
2. What is Supercomputer?
3. Put into an increasing order the units of computer performance – Mflops, Flops, 

TerraFlops, GFlops, KFlops.

Supercomputer performance
barrier year FLOPS
FLOPS 1941 100
KFlOPS 1949 10³
MFLOPS 1964 106
GFLOPS 1987 109
TFLOPS 1997 1012
PFLOPS 2008 1015
EFLOPS 2010 1018
ZFLOPS − 1021
YFLOPS − 1024
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Let us remember:
Cluster – a group of computers, united by a high-speed connection which from the point of 

view of the user represent a single resource (e. g. several processor cores combined and working 
as one processor).

FLOPS – (FLoating point Operations Per Second) – the number of floating point operations 
that a computer can perform in one second. 

1. Grid technology
Grid technology combines many computer resources (e.g. processor time, data storage space, 

etc.), located in different places. The purpose of this unification is to achieve a common goal. The 
main difference between grid and high-performance computer systems, such as, clusters is that 
with grid each node (networked computer) performs a different task. Another difference is the 
geographical location of the computers - in clusters the computers are located close to each other 
while in grid we have more scattered nodes. One grid can be used for a specific application but is 
most often used for different purposes.

Fig. 1. Grid
One of the strategies used by grid is the use of the so-called Middleware, which divides and 

distributes parts of the program between several computers. It is possible that the number of these 
computers will reach several thousand.

The size of a grid can vary from small, limited to a company or corporation network, to 
large, which are used to collaborate between multiple companies and networks. The term "closed 

2. grId and Cloud ComputIng
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grid" is used for the interaction between internal computers on the network, and “broad grid” 
refers to the communication between all nodes.

We can imagine grid as a virtual supercomputer, which is composed of many interconnected 
computer networks working together to perform a large task. This technology is used where 
intensive calculations are required: scientific and academic tasks, discovery of new drugs, economic 
forecasting, seismic analysis, web services and more.

2. CLOUD technology
Cloud technology or Cloud computing is the provision of computer services to users. For 

this purpose, the user connects via the Internet or through a specially leased communication line 
to a remote computer. The term Cloud also means the use of shared resources – software and 
information - located on computers and other network devices.

The term Cloud Computing combines the following concepts:
Software as a service – the necessary software and data are located in a cloud on the Internet 

and are provided to the user using a special client program, e.g. web browser.

Fig. 2. Cloud computing

Infrastructure as a service – servers, equipment, computing power, etc., are provided for 
using by different users. The necessary resources, such as processors, memory, storage space, 
communication, etc. are hired by an external company – supplier, which has the necessary 
equipment and takes care of its maintenance.

Platform as a service – a type of service in which the Cloud Computing provider allows 
the user to develop and use various applications without having the necessary platform – software 
and infrastructure.
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Generally speaking, the term Cloud technology refers both to the use of various software 
applications provided in the form of web services and to access to the hardware resources of the 
provider of these services. When we say “cloud”, we mean exactly the combination of access to 
software and hardware through the use of a computer network (usually the Internet). Some experts 
consider “cloud” and the Internet as similar concepts, because in computer network diagrams, the 
Internet is represented as a cloud.

Fig. 3. Cloud computing features
The use of cloud technologies saves tenants the cost of purchasing software licenses, 

hardware, staff training and more.
Building and maintaining a cloud system requires huge resources and for this reason the 

supplier companies are relatively few – Amazon, Google, Microsoft, Apple iCloud, Salesforce, 
Sun Microsystems, IBM, Oracle, VMWare.

In Bulgaria, the provider of cloud services is the company Cloud.bg.

Glossary
Grid technology combines many computer resources (e.g. processor time, data storage space, 

etc.), located in different places.
Cloud technology or Cloud computing is the provision of computer services to users. For 

this purpose, the user connects via the Internet or through a specially leased communication line 
to a remote computer.

Questions
1. Describe some of the advantages and disadvantages of grid and Cloud technologies.
2. Point out some differences between grid and Cloud technologies.
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1. Using your G Workspace account
Once you have Google Workspace account you also have access to many different online 

applications such as Google Docs, Sheets, Slides, Sites and more. After you log-in to your account 
you have access to these applications by clicking on the grid-like icon in the top right corner of 
the screen.

Fig. 1. GWorkspace
• Create or import files

 ) Create a new file
In Docs, click Blank “+”.

Fig. 2. GWorkspace

3. workIng In google for eduCatIon and 
mICrosoft offICe 365 Clouds
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In Drive, click New and then next to Google Docs/Sheets/Slides, point to the Right arrow 
“>” and click Blank document/spreadsheet/presentation or Form a template.

Fig. 3. GWorkspace

Fig. 4. GWorkspace

 ) Import and convert existing files
If you have existing files, you can import and convert them to Docs, Sheets, or Slides.
If you want to convert your files automatically then go to Settings and check the “Convert 

uploaded files to Google Docs file converter” option and then click Done.

Fig. 5. GWorkspace

Fig. 6. GWorkspace
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a. Go to your Google Drive.
b. Click New and then File Upload.
c. Choose the file you want to import from your computer to add it to Drive.
d. Click Open.
Converting your file from another program creates a copy of your original file in a Docs, 

Sheets, or Slides format. You can then edit the file in your browser.

Fig. 7. GWorkspace 

 ) Import existing folders
a. Go to your Google Drive.
b. Click New and then Folder Upload.
c. Choose the folder you want to import from your computer to add it to Drive.
d. Click Upload.

Fig. 8. GWorkspace

 ) Sharing files and folders
a. Select the file or folder you want to share.
b. Click “Share” or “Get link”.
c. Under “Get Link,” click “Change” and select “Anyone with the link” option.
d. To decide what people can do with your public link when you share it, select Viewer, 

Commenter, or Editor.
e. Click Done.
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Fig. 9. GWorkspace

Fig. 10. GWorkspace

Fig. 11. GWorkspace
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If you want to share your file or folder with specific people, you can write their e-mails in the 
“Add people and groups” field and then click Done.

Fig. 12. GWorkspace

2. Using Microsoft Office 365 Cloud
• Create or import files.

 ) Create a new file
To create a new text file, spreadsheet, PowerPoint presentation or other you can use either 

the shortcut buttons on the left side of the screen or the  button.

Fig. 13. Office365
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 ) Import existing files
If you have existing files, you can import them by using the “Upload” button.

Fig. 14. Office365

 ) Import existing folders
To view and organize all your files you should use Microsoft OneDrive application. To 

access it, use the grid-like icon in the top left corner of the screen. You have access to all Microsoft 
applications from there.

Fig. 15. Office365 Fig. 16. Office365

Use the New or Upload button to create new File/Folder 
or to upload an existing one.
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 ) Sharing files and folders
a. Select the file or folder you want to share.
b. Click Share or Copy link.
c. Click “People in…,” to change Link settings.
d. Select people that you want to share your file/folder with and what they can do with 

your public link when you share it.
e. Click Apply and then Send.

Fig. 17. Office365

Fig. 18. Office365
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1. History
The Global Positioning System (GPS), originally Navstar GPS, is a collection of space 

satellites, transmitters and ground receivers. The main purpose of this system is to determine the 
location of an object in real time, the distance traveled, speed, trajectory over the entire earth's 
surface. Each satellite involved in the system has a signal transmitter. 

Fig. 1. GPS

GPS was developed by the US military and was originally used only for military purposes. 
The first satellite was launched on February 22, 1978. Over the next two years, the number of 
satellites in orbit rose to six. By the end of 1993, there had already been 24 satellites covering the 
entire globe, and in January 1994, the system began full operation.

Although originally intended for military use, GPS is now free and available worldwide for 
both military and civilian use. The reason for this was an accident with a South Korean civilian 
plane, which due to a navigation error entered the borders of the USSR and was shot down by 
a Soviet fighter jet. As a result, 269 people died. This made the US authorities realize that such 
incidents can be avoided via the use of GPS and allowed it for civilian use.

Currently, the GPS space network consists of 24 main working satellites and several additional 
ones, which are used in case of accidents. They orbit the globe at an altitude of about 19,300 km, 
making 2 full revolutions per day. The orbits of the satellites are calculated so that signals from at 
least 4 satellites can be received at any time from anywhere on Earth. The signals are received by 
special receivers, which process them and determine their exact location.

4. global posItIonIng systems
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Fig. 2. GPS
Apart from the US GPS there are two other systems:
GLONASS is a Russian space-based satellite navigation system operating as part of a 

radionavigation-satellite service. It provides an alternative to GPS and is the second navigational 
system in operation with global coverage and of comparable precision.

Galileo is a global navigation satellite system that went live in 2016, created by the European 
Union through the European Space Agency (ESA), operated by the European Union Agency for 
the Space Programme (EUSPA), headquartered in Prague, Czech Republic, with two ground 
operations centers in Fucino, Italy, and Oberpfaffenhofen, Germany.

2. GPS Structure
This GPS consists of three segments: the space segment, the control segment and the user 

segment. The U.S. Space Force develops, maintains, and operates the space and control segments.
a. The GPS space segment consists of a constellation of satellites that fly in medium Earth 

orbit transmitting radio signals to users and also includes the payload adapters to the boosters 
required to launch them into orbit. As of February 2019, there are 31 satellites in the GPS 
constellation, 27 of which are in use at a given time with the rest allocated as standbys. 

The United States is committed to maintaining the availability of at least 24 operational GPS 
satellites, 95% of the time.

b. The control segment (CS) is composed of:
1. a master control station (MCS),
2. an alternative master control station,
3. four dedicated ground antennas,
4. six dedicated monitor stations.
The MCS can also access Satellite Control Network (SCN) ground antennas (for additional 

command and control capability) and NGA (National Geospatial-Intelligence Agency) monitor 
stations.
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The operation control segment (OCS) currently serves as the control segment of record.  
It provides the operational capability that supports GPS users and keeps the GPS operational and 
performing within specification.

OCS will continue to be the ground control system of record until the new segment, Next 
Generation GPS Operation Control System (OCX), is fully developed and functional.

The user segment is composed of hundreds of thousands of U.S. and allied military users of 
the secure GPS Precise Positioning Service and tens of millions of civil, commercial and scientific 
users of the Standard Positioning Service.

3. How does the global positioning system work?
The transmitters in the satellites transmit regular signals about their own position and exact 

time. These signals travel at the speed of light and signals from at least three different satellites 
reach each point on the earth's surface simultaneously.

The GPS receives these signals and calculates how long it takes for the messages to reach it. 
Based on these calculations, it can determine its exact position. This is based on a mathematical 
principle called trilateration in three-dimensional space.

Fig. 3. GPS

What is trilateration?
To simplify the explanation, we assume that each satellite emits a signal that reaches the 

Earth in the form of a circle. If a signal reaches a point on the Earth's surface, it is inside this circle 
and if there is no signal, it is outside it. The circle of the second satellite intersects the first partially 
and in this intersection area we have a signal from both satellites. However, the signal (circle)
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of the third satellite intersects those of the first two at only one point and this is the exact position 
of the signal receiver. The more signals a receiver receives, the more accurately it determines its 
position.

Fig. 4. Trilateration
In fact, the shape of the received signals is not a circle, but a sphere. This means that the three 

spheres will not have one but two intersection points. The receiver “uses” the Earth as a fourth 
sphere to determine in which of these two points it is at a given time.

GPS and time
In order to correctly calculate the spheres in which it is located, the receiver must “know” 

the exact distance to each of the satellites. The time for which the signals arrive from the satellite 
to the receiver is necessary to achieve this goal.

How does this happen?
At some point, the satellite begins to emit a long signal. Exactly at the same time, the receiver 

starts executing the same signal. After reaching the signal from the satellite to the receiver, the 
latter calculates the delay and by using the speed of light at which the signal travels, calculates the 
distance from itself to the satellite.

4. Obstacles to GPS
In order to correctly calculate the distance between a satellite and a receiver, it is necessary for 

both devices to have extremely accurate clocks that can synchronize their work to the nanosecond. 
For this purpose, the satellites have atomic clocks. They are precise enough but due to their high 
price (between 50,000 and 100,000 dollars) ordinary quartz clocks are used in the receivers. 
However, their synchronization is not as good as that of the atomic ones. To avoid this problem, 
the quartz clocks in the receivers are constantly reset, and thus the calculations use the absolutely 
synchronized time from the atomic clocks in the satellites.

The satellites move in predefined orbits and each receiver has the so-called almanac that 
contains information about the exact position of each satellite in every second. Using the data 
received from the signals and the almanac, the receiver calculates a correction that is applied to its 
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own clock and thus determines its exact coordinates. After finding the “correct” time, the quartz 
clock on the receiver is reset. And because this happens all the time, the quartz clock turns out to 
be almost as accurate as the atomic one in the sky.

Another obstacle to GPS is the slowing down of the satellite's signal as it enters the 
atmosphere. This delay may vary depending on the exact location of the receiver. The signal can be 
reflected by various large objects such as hills or skyscrapers and this can lead to additional delays. 

Sometimes the information provided by the satellites to the receiver's almanac can also be 
incorrect. 

Additional correction systems are available to avoid these errors and to achieve maximum 
measurement accuracy. The land-based stations with exactly known coordinates are an example 
of this.

Glossary
Global positioning systems - a collection of space satellites, transmitters and ground receivers 

used to determine the location of an object in real time.
Trilateration - determining a position by knowing your distance from at least 3 known points. 

It uses lines of known length but unknown angle (circles in other words) to find a point.

Tasks
1. Using a GPS receiver determine the exact coordinates of your home.
2. Using a GPS receiver create a route from home to school.
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1. What is a computer network?
A computer network consists of two or more computers (or other communication devices) 

connected to each other by suitable hardware and software. The main purpose of connecting 
electronic devices to a network is to share common resources – storage space, printers, memory, 
CPU time and more.

2. Brief history of computer networks
The emergence and development of computer networks began in the middle of the twentieth 

century, when in order to better communicate and manage the US military decided to connect 
their computers to a network. Their main goal was to create a sustainable and reliable network that 
would survive a nuclear war.

Working together, scientists at MIT, the RAND Institute and the National Physics Laboratory 
(NPL) in the UK invented a new technology for transmitting information called packet switching. 
This technology is still used today.

In the late 1960s, again under the auspice of the US Department of Defense, the first packet-
switched computer network called the ARPANET (Advanced Research Projects Agency Network) 
was created. In 1969, the first node (access point) to the ARPANET was installed at the University 
of California, Berkeley. A rapid development followed and in just five years the network covered 
the entire United States and reached Europe.

ARPANET existed until the 90s of the twentieth century when the Internet appeared. Later 
the Internet Society was formed and in 1994 the W3C organization was also established.

3. Advantages and disadvantages of computer networks
Advantages
• Access to shared resources such as CPU time, disk memory, files, I / O devices, and more. 

Sharing these resources reduces hardware costs.
• The performance of low-performance computers increases, for example they use the CPU 

time or disk memory of another computer.
• Enable access to shared databases and storage systems.
• Increase the efficiency of the work process by providing an opportunity for collective work 

on projects in a group, etc.
• They allow for fast electronic communication and distance learning.
• They can be connected to other networks.
Disadvantages
• Network Device Vulnerability – any device connected to a network can be attacked by 

malicious users.
• Reducing the network efficiency through congestion both locally and globally.
• Technical problems with connected devices disrupting connectivity between individual 

computers.

5. loCal and global Computer networks

II. Computer networks and servICes
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4. Classification of computer networks
According to the distance at which they are located
Local area network – covers one or several closely spaced buildings at most.
Wide Area Network – is located over long geographical distances, i.e., in one or more 

countries. The most famous global network is the Internet, which covers the entire globe.

According to the functions of the nodes connected in the network
Peer-to-peer networks – all computers simultaneously provide and receive services on the 

network.
Client-server networks – one computer is a server (provides services and manages the 

network) and the others only use the services provided to them.

According to the physical topology
Physical topology – a way of physical location and connection of computers in the network.

• Bus topology – all computers/devices are connected to the same communication medium 
(a cable), through which the information is transmitted.

• RING topology – computers are connected in series with each other.

• Star topology – all devices are connected to one central device, most often а switch.

• Grid (mesh) – each computer has a direct connection to any other computer. This type 
is not often used. Due to the very rapidly growing number of connections, only a few 
computers are involved.

• Mixed or hybrid topology – a combination of two or more different topologies.

Fig. 1. BUS Fig. 2. RING
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Fig. 3. STAR

Fig. 4. MESH

Fig. 5. Hybrid



28

According to the connection technology
Cable and wireless networks
In addition to physical, each network has a so-called logical topology. It is determined by the 

way the information is transmitted between the individual devices. According to their functions, 
devices in a network can be defined as end devices and intermediate devices. Intermediate devices 
provide network management and signal transmission in the network, whereas and the end devices 
are called workstations.

Questions and tasks:
1. Point out the differences between LAN and WAN.
2. What is the difference between a server and a workstation?
3. Indicate the difference between physical and logical topology.
4. Point out some of the disadvantages of computer networks.
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Everything that you can do online is located somewhere on the Internet. Social media sites, 
multi-player games, messaging centers that provide email, online courses – all of these Internet 
destinations are connected to local networks that send and receive information through the Internet.

Think about all of the activities that you have during the day which require you to be online. 
Use this worksheet to make a list to share with your classmates. Add additional lines or pages if 
necessary.

Sample:

6. Computer networks – what I Can do on-lIne? 
exerCIse

Time Device Activity Reason Alternative

8:00 am Phone Check email Address any 
important messages none

8:15 am Phone Check overnight 
text messages

Update myself on 
what’s happening Call everyone?

8:30 am Desktop

Login at Google 
Classroom/

Microsoft teams to 
check assignments

Get ready for class
Printed calendar, 
course schedule, 

and syllabus

8:35 am Phone Check Facebook 
and Instagram Update

Print and share 
pictures. Copy 

videos to thumb 
drive and show 

people in person.

9:00 am Phone Played  
“Angry Birds” Entertainment Boredom

Noon Phone
Used Google maps 
to find closest pizza 

restaurant
Hungry Call directory 

assistance
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Your Activities:

Continue the list on a separate page if necessary.
Reflection
How many of your daily on-line activities would not be possible without being connected to 

the Internet or a local network?
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
How many different devices did you use to accomplish your on-line activities?
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
 

Time Device Activity Reason Alternative
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1. Network services
 ) Local area network services

The resources in the local network called network services are provided by the so-called 
server. A server is an application program that implements a given service. With good enough 
technical parameters one computer system can serve several servers simultaneously.

Frequently used services:
• File server – allows you to store and download files.
• Print server – provides access to the printer on the computer on which it is installed.
• E-mail server – used to manage clients' mailboxes.
• Web server – provides information in the form of html documents.

 ) Internet Services
•  World Wide Web (www) – the most commonly used multimedia service on the Internet. 

The information is provided in the form of hypertext documents.
• File transfer – allows you to exchange files between different applications.
• Remote access or Terminal Network (Telnet) – by using special programs allows 

access to a remote computer in order to run applications or access data on its hard drive. 
This is one of the first services to appear on the Internet.

• E-mail – ensures the sending and receiving of e-mails. The user needs to have a valid 
e-mail address.

• Internet telephony or Voice over Internet Protocol (VoIP) – this service allows the 
transmission of voice and multimedia information in the Internet environment using IP 
packets. It offers a cheap option for long distance calls.

• Internet Relay Chat/IRC – allows for real-time communication between users. After 
connecting to a special IRC server, the user receives a username and can send messages 
to all chat participants or only to selected ones.

• Internet of Things – a new technology that allows devices to communicate with each 
other and respond to changes in the environment.

2.  Structure, organization, and rules of working on the Internet
The Internet is a global network that connects large and small local area networks located 

around the world. The structure of this network is hierarchical – networks at different levels are 
used. These networks have different complexity and importance.

Most of the applications/services on the Internet use client/server technology, in which the 
server executes a request for a service by the client. A special program is used for this purpose, 
e.g., Web Browser.

To communicate with each other, devices on the network use a set of rules – software 
programs – called protocols, which are integrated into the TCP / IP packet. The protocols “tell” 
the network how to offer its services and how to perform its functions. For a given service, e.g. an 
e-mail – there may be more than one protocol in use. All modern operating systems support the 

7. network servICes. Internet
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TCP/IP package and provide Internet access to users.
In addition to these software rules, there are others used on the Internet. Some of them are 

determined by the organizations offering access to the Internet, and others are a consequence of 
certain ethical norms.

Examples of such rules are:
• Avoiding illegal access to foreign information resources.
• Prohibition of spreading unwanted information (spam).
• Prohibition of spreading personal information and information protected by the laws of 

different countries.
There are many other similar rules, which are united by the common name Netiquette – from 

the words “internet” and “etiquette”.

Glossary:
Protocol – a set of software rules under which applications exchange information.

Questions and tasks:
1. What is a protocol?
2. Point out what services you know on the Internet.
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Let's remember: Devices in a computer network are called nodes. They can be end or 
intermediate.

1. Basic communication devices
• Network interface controller (NIC) or LAN card – each device (node) in a computer 

network must have a LAN card to connect to the network. Depending on how you 
connect, LAN cards can be wired or wireless.

Fig. 1. NIC
• A modem/modulator/demodulator – an intermediate communication device for 

transmitting digital signals on analog (telephone or television) lines. It is most commonly 
used to connect individual users to a LAN or WAN. Access to the local network is 
provided by the so-called RAS-server (Remote Access Server). Modems can be external 
or internal. Currently, modems are most often used by television operators to deliver 
Internet on television lines. The technology for transmitting information over telephone 
lines is called DSL. It allows the simultaneous transmission of voice and data on one 
line.

Fig. 2. Modem

8. basIC CommunICatIon devICes  
and CommunICatIon envIronments
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Fig. 3. bgModem – Bulgarian modem
• A switch - an intermediate device that allows you to connect additional devices to the 

local network. The entry points through which this is done are called ports, and the 
switch is called a multiport. There are 8, 16, 24, 32 port switches. The switch maintains 
the data rate on all its ports. It also allows connection to another switch, which increases 
the area covered by the LAN.

Fig. 4. Switch

Fig. 5. Switch1



35

• A router - an intermediate device with more functions than the switch. The router 
connects two separate networks while managing them and eliminating the differences 
between them. Also, the router can be used to divide a large network into several smaller 
ones. When there are several routes in the network for the information to reach the end 
device, the router chooses which of them to transmit the data to. Another function of the 
router is to serve as an entry point for Internet access and its distribution between end 
devices in the local network.

Fig. 6. Router
• An access point - an intermediate device in wireless networks that helps devices to 

connect to the network and use its services.

Fig. 7. AP
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2. Communication media
Depending on the transmission medium used by computers networks are divided into wired 

and wireless.
The cable transmission medium can be comprised of the following types of conductors:
• A twisted pair of wires – consists of eight copper wires divided into pairs. Each pair is 

twisted and isolated from the others in order to reduce the influence of external factors 
on the transmitted information. There are two types of cables of this kind – Shielded 
Twisted Pair (STP) and Unshielded Twisted Pair (UTP). STP is more expensive and 
is used in places with high electromagnetic interference, while UTP is more flexible 
and inexpensive and is used in places where there is less electromagnetic interference. 
Modern LANs use UTP. The maximum length at which this cable can be used without a 
repeater (Fig. 10) is 100m.

Fig. 8. UTP

Fig. 9. STP
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Fig. 10. Repeater
• A coaxial cable – a conductor covered with insulation, copper braid and outer sheath. 

The braid is used to shield the wire. 
Some coaxial cables have a first insulating layer of foil and a second of braid. They are called 

double shielded. There are two types of coaxial cables – thinnet and thicknet. The thinnet one can 
carry information up to 185 m, and the thicknet one up to 500 m. Coaxial cable provides better 
protection against electromagnetic interference than a twisted pair cable.

Fig. 11. Coaxial
• Fiber optic cables – they are made of individual fibers made of glass or plastic. Each 

optical fiber consists of a core and a sheath and has a different refractive index. Thus, the 
information in the individual fibers of a cable cannot be intertwined. This also makes the 
cable flexible and allows it to be bent and twisted.
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Fig. 12. FiberOptic
Fiber optic cables are the best transmission medium compared to coaxial cables and twisted 

pair because they are more resistant to signal attenuation and allow information to be transmitted 
over long distances. They also maintain high transmission speeds and are not susceptible to 
electromagnetic interference.

There are two types of transmission of information over a fiber optic cable:
•  Single mode – light travels along the axis of the cable. Allows transmission of information 

up to 200 km and is used when building a WAN.
•  Multiple mode – light enters the fiber at different angles and is refracted and reflected 

from the cable sheath. It is used in LAN networks and provides transmission of distances 
up to 500 m.

• Wireless environment – allows the transmission of information to take place without 
a cable. Lasers, infrared waves, radio frequencies can be used for this purpose. The 
transmission speed is slower than cable media. Wireless environment is used in Wi-Fi 
networks and in the networks of mobile operators.

Glossary:
Media – physical medium for transmitting information.
Repeater – a device that receives and transmits electrical, optical and wireless signals. 

Preserves signal quality and increases the distance over which data can be transmitted.
Internet Service Provider (ISP) – a company that provides individual home and office 

users with access to the internet.

Questions and tasks
1.  Specify the differences between a switch and a router.
2. Which cable provides the best transmission environment?
3. Specify the correct order of the following terms: a switch, a printer, a router, a wireless 

access point, an internet provider, a laptop.
4. Describe the devices involved in building your home Internet connection. What kind of 

transmission medium does your ISP use?
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The path that a message takes from its source to destination can be as simple as a single cable 
connecting one computer to another or as complex as a network that literally spans the globe. The 
network infrastructure contains three categories of hardware components:

• End devices.
• Intermediary network devices.
• Network media.
Take a close look at the network you have at school. Record the network and end-user 

devices that are connected to the local network.

Sample

9. basIC CommunICatIon devICes  
and CommunICatIon envIronments – exerCIse

Manufacturer Device Location Connection Media

Apple iPhone Mobile Wireless WiFi & cell phone

Samsung Galaxy Smart 
Phone Mobile Wireless WiFi & cell phone

Cisco Cable Modem Home office Wired Cable TV coaxial cable and 
Ethernet cable

Linksys Wireless Router Home office Wired Ethernet cable

HP Printer/Scanner Home office Wireless WiFi

Apple MacBook Air Mikayla’s 
Room Wireless WiFi

Beats by Dre Headphones My Room Wireless Bluetooth

Microsoft Xbox My Room Wired Ethernet Cable
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Your Activities

Continue the list on a separate page if necessary.
Reflection
1. Are there other electronic devices that are not connected to the local network to share 

information or resources? What would be the benefit of having these devices online?
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________

2. Which type of connectivity is used most frequently in your local network, wired or 
wireless?

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________

3. Draw a diagram of your local network. Label each device with a name and location.
 

Manufacturer Device Location Connection Media
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1. Network protocols 
Let's remember: A protocol is a set of rules that determine how the devices connected to 

the network change information. 
Internet Protocol (IP) – basic protocol in the network. It is used to determine the route along 

which the data packet is to be transmitted from the initial device (source), through the intermediate 
devices (switch, router, etc.) until the final device (receiver) is reached. To implement this function 
IP addresses are used. They uniquely identify each computer in the network, as well as to which 
network it belongs. Some devices – such as routers – may have more than one IP address.

Transmission Control Protocol (TCP) – a transport protocol that uses pre-established logical 
connections to transmit information between two communicating devices. Steps in transmitting 
information via TCP: 

• A logical connection, which is called a session, is built, i.e. the two devices have “agreed” 
on all connection parameters.

• The information is transmitted in the form of packets. In this process, the TCP is 
responsible for avoiding mistakes and for the packages' correct arrangement.

• The logical connection between the two devices breaks down.
TCP can support multiple logical connections at once. For this reason, we can open several 

websites at the same time, listen to music on the Internet, download files and more.
User Datagram Protocol (UDP) – faster than TCP. In this case, no logical connection is 

established and the order of the packets is not monitored. For this reason, it is unreliable. Suitable 
for messages that can only be transmitted with one packet.

Hypertext Transfer Protocol (HTTP) – protocol for transmission of hypertext documents. 
A hypertext is a document that contains references (hyperlinks or only links) to other hypertext 
documents. This protocol works on the client/server scheme. The customer can be, e.g., a browser 
or other application that sends a request to an HTTP server. Requests use Uniform Resource 
Locator (URLs) addresses.

URL is a system for naming resources (files) in the network. Each URL consists of three 
parts: protocol type, computer name, full path to the file.

Example: http://1eg.eu/dokumenti/etichen-kodeks.pdf

Simple Mail Transfer Protocol (SMTP) – e-mail protocol. Ensures the transmission of an 
electronic message between the sender's and recipient's mail servers. It is usually used to send 
e-mail.

Post Office Protocol, version 3 (POP3) or Internet Message Access Protocol, version 4 
(IMAP4) – protocols for reading and processing e-mail after receipt and on the recipient's server. 
One of the two protocols is used.

10. ConneCtIng and ConfIgurIng a small 
network

Protocol type computer name Path to the file / searched resource /

http:// 1eg.eu /dokumenti/etichen-kodeks.pdf
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File Transfer Protocol (FTP) – used to exchange (transfer) files.
Dynamic Host Configuration Protocol (DHCP) – is used for automatic configuration of 

devices on the network (setting the IP address, default gateway, etc.) without the intervention of 
an administrator. 

Fig. 1. DHCP

2. Computer address (IP address)
There are two different standards for presenting IP addresses, depending on the version of 

the IP protocol used. The current version is version four and is denoted by IPv4, and the newer 
standard is version 6 – IPv6.

For IPv4, the IP address is 4 bytes and is written with four numbers between 0 and 255 
separated by a period.

For example: 192.168.1.240
Each IP address is logically divided into two parts - the network address (NetID), to which 

the host belongs and the address of the host (HostID).

Depending on the scope, IP addresses are divided into public and private. Public IP addresses 
are valid throughout the network. Private IP addresses are used when configuring local area 
networks so that public addresses are not occupied. They only work on the network in which they 
are set. When the local network connects to the Internet, private addresses are converted to public 
ones. This function is performed by the router that connects the LAN to the Internet.



43

3. Subnet mask
The network mask is the one that determines which part of the IP address shows the network 

address (NetID) and which host address (HostID). Subnet masks are 4 bytes as IP addresses and 
cannot exist on their own. Standard network masks use two numbers – 0 and 255. Where there are 
255's is the network address and zeros indicate the host address.

For example:

Fig. 2. IP

4. Domains
It is customary on the Internet to replace host IP addresses with names that make it easier for 

the user to use them. These names are arranged in a tree-like, hierarchical structure in the form of 
domains of names (Domain Names), which are called domains.

These names are managed by a system called the Domain Name System. The main function 
of this system is to associate an IP address with names. This allows the grouping of domains 
according to certain criteria – geographical area, affiliation to an organization, etc.

At the top of the hierarchy are three-letter designations for belonging to an organization or 
two-letter designations for belonging to a particular country. These are called top-level domains.

Examples:
• edu – educational institutions
• com – Trade (COMmercial) organizations
• org – other types of organizations
• bg – Bulgaria
• de – Germany
Users (people and organizations) can register second level domains – google.com, 1eg.eu. 

The second part (from right to left) of the name identifies the organization and each subsequent one 
is the name of a smaller division, the name of a computer or a device called a lower-level domain.

For example, in the address https://tests.1egit.eu/ – tests is a domain in the field 1egit.eu / 
third level domain, subdomain /

Glossary:
host – a device connected to a computer network.
Default gateway– a network node that serves as an access point to another network.

Questions and tasks
1. What is a host?
2. What is the subnet mask used for?
3. What is the difference between a network address and a host address on it?
4. What is DNS for?
5. What is the role of a DHCP server in a network?
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Topology

Fig. 1. Building a network

Addressing Table

Part 1: Set Up the Network Topology (Ethernet only)
In Part 1, you will cable the devices together according to the network topology.
Step 1: Power on the devices.
Power on all devices in the topology. The switches do not have a power switch; they will 

power on as soon as you plug in the power cord.
Step 2: Connect the PCs to the switch.

a. Connect one end of an Ethernet cable to the NIC port on PC-A. Connect the other end of 
the cable to F0/6 on S1. After connecting the PC to the switch, you should see the light for F0/6 
turn amber and then green, indicating that PC-A has been connected correctly. 

b. Connect one end of an Ethernet cable to the NIC port on PC-B. Connect the other end of 
the cable to F0/1 on S1. After connecting the PC to the switch, you should see the light for F0/1 
turn amber and then green, indicating that the PC-B has been connected correctly. 

Step 3: Visually inspect network connections.
After cabling the network devices, take a moment to carefully verify the connections to 

minimize the time required to troubleshoot network connectivity issues later.

11. buIldIng a sImple network

Device Interface IP Address Subnet Mask

PC-A NIC 192.168.1.10 255.255.255.0

PC-B NIC 192.168.1.11 255.255.255.0
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Part 2: Configure PC Hosts
Step 1: Configure static IP address information on the PCs.
a. To configure the Network Settings on PC-A, click Start, then click Settings.

Fig. 2. Building a network

b. In the Settings window click Network & Internet.

Fig. 3. Building a network
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c. In the left pane select Ethernet, then click Change adapter options.

Fig. 4. Building a network

d. The Network Connections window displays the available network interfaces on the PC. 
Right-click the Ethernet0 interface and select Properties.

Fig. 5. Building a network
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e. Select the Internet Protocol Version 4 (TCP/IPv4) option and then click Properties.

Fig. 6. Building a network
Note: You can also double-click Internet Protocol Version 4 (TCP/IPv4) to display the 

Properties window.
f. Click the Use the following IP address radio button to manually enter an IP address, subnet 

mask, and default gateway. Type in the IP address 192.168.1.10 and the subnet mask 255.255.25.0.

Fig. 7. Building a network
Note: In the above example, the IP address and subnet mask have been entered for PC-A. 

The default gateway has not been entered because there is no router attached to the network. Refer 
to the Addressing Table on page 1 for PC-B’s IP address information.
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g. After all the IP information has been entered, click OK. Click OK on the Ethernet0 
properties window to assign the IP address to the LAN adapter.

h. Repeat the previous steps to enter the IP address information on PC-B.
Step 2: Verify PC settings and connectivity.
Use the Command Prompt to verify the PC settings and connectivity.
a. From PC-A, right-click Start, select Command Prompt.

Fig. 8. Building a network
b. The cmd.exe window is where you can enter commands directly to the PC and view 

the results of those commands. Verify your PC settings by using the ipconfig/all command. This 
command displays the PC hostname and the IPv4 address information.
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Fig. 9. Building a network
c. Type ping 192.168.1.11 and press Enter.

Fig. 10. Building a network

Were the ping results successful? ______________________
If not, there is a good chance that Windows Firewall is blocking ICMP echo requests (ping). 

Click Start > Settings > Network & Internet > Ethernet > Windows Firewall to turn it off.
Note: If you did not get a reply from PC-B, try to ping PC-B again. If you still do not get a 

reply from PC-B, try to ping PC-A from PC-B. If you are unable to get a reply from the remote PC, 
ask your instructor to help you troubleshoot the problem.
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1. Shared resources 
One of the main advantages of LAN is the ability to share resources in it. To implement this 

function, we must have the necessary hardware devices and specialized software.
Hardware devices include clients, servers, peripherals such as printers, plotters, disk drives, 

and more.
The specialized software covers the operating system used and the drivers of the respective 

devices.
The set of these tools is called network resources.
The main software that provides the ability to communicate between devices and share 

resources is the computer's operating system. Such a system is called a network operating system. 
All modern operating systems also support network functions.

To allow remote access to a resource (device or data), we need to create a shared resource. 
Resources given in this way are called shared. They are accessed in two ways:

• Through peer-to-peer networks.
• Through client/server networks.

2. Peer-to-peer networks – in these networks, each computer performs the functions of 
both a server and a client. Each user of the network administers the resources of his system. Due 
to the lack of a separate server computer, there is no hierarchical organization.

Advantages:
• Cheap to implement and install. There is no need of expensive server systems and staff 

to administer them.
• Greater stability compared to client/server networks. If the server stops working, access 

to the resources shared by it is terminated. In peer-to-peer networks if one workstation 
stops working, this does not cause the whole system to crash.

Disadvantages:
• Multiple passwords to access the resources of individual computers are needed. This 

forces users to keep copies of these passwords and creates a security issue.
• Users have different levels of technical knowledge, which also violates network security.
• Due to the lack of a central place to store shared resources, finding certain information 

becomes difficult. It is also difficult to maintain archive (backup) copies of the data. 
There is no guarantee that the user responsible for any information will perform this 
operation.

• Workstation performance may slow down when a remote user gets access to shared 
resources.

• The workstation must always be turned on to access shared resources, even if the user 
working on it is not.

• It is difficult to expand because the larger the network, the harder it is to manage. They 
are suitable for small organizations.

12. network resourCe sharIng
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3. Client/server networks – they support central administration by a computer that 
works with specialized server software and network operating system. Each user gets access to 
the shared resources by entering a username and password. Access is granted by the server after 
verification of the entered data. The shared resources are located on separate computers (servers), 
which do not have a main user.

Advantages:
• Network security is managed centrally. All usernames and passwords are administered 

and verified centrally before a user gets access to a shared resource.
• Data backups are easy to maintain.
• There is no need to search for data on the network - they are stored in one place.
• The servers have powerful processors, more memory, larger and faster disks.
• It is easy to expand. Resources are located in one place and are managed centrally. The 

operation of the network does not depend on its size.
Disadvantages:
• High cost of server hardware and software.
• Specially trained staff takes care of their administration.
• Ability to deny the server. Different ways are used to overcome this problem, which 

leads to an increase in the cost of the network.

4. Network resource sharing
This process is managed and administered by the network operating system. Its function is 

to provide means to control access to shared resources. This is done in two ways:
• Share-level security.
• User-level security.
a) security at the level of shared resource - in this case the sharing of a resource, e.g. Folder, 

requires a password. To access the shared folder, the user must enter the correct password upon 
request.

b) user-level security - this method of protection is easier to manage in medium and large 
networks. Each user has an account (a username) and a password. Shared resources are configured 
so that only users with valid accounts can access them. This also allows tracking of whom is 
accessing a particular resource.

Questions and tasks
1. List some network resources in the LAN.
2. Which resources are called shared?
3. How many types of local networks do you know according to the way they are 

administered?
4. What levels of security can be achieved when sharing resources?
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1. Folder Sharing in Windows 10 
To share a folder in Windows 10, follow these steps:
a) Start Windows Explorer and find the folder you want to share.
b) Right-click on the folder and from the context menu select Properties – Fig. 1.

Fig. 1. Share
c) Select the Sharing tab and click the Share button. A new window opens where you need to 

specify an individual user or group which to share the resource with. To do this, use the drop-down 
menu to the left of the Add button. For example, the group Everyone is wanted. If it is missing, you 
should write it and then click on the Add button. The selected group should appear in the list below.

d) From Permission Level select the folder sharing level: Read - read only, Read/Write – 
read and write (allows modification and deletion) – Fig. 2.

Fig. 2. Share

13. network resourCe sharIng – exerCIse
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e) It is confirmed with the Share button, after which a new window appears, indicating the 
way of writing the path for access to the folder from a computer in the local network – Fig. 3.

f) Confirm with the Done button.

Fig. 3. Share
To allow access to the shared folder through the Security tab, follow these steps – Fig. 4.
a) Select the Security tab and check whether the user or group with which the folder is 

shared exists in the suggested list. Usually, after using the Share button, the necessary changes to 
the Security tab are made automatically. If the target user or group is not in the list, they need to 
be added via the Add button.

b) From the series of windows named Select Users or Groups, select the Advanced button, 
then Find Now to find the desired user or group and add them to the list of permissions.

Fig. 4. Share
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Access a shared folder via LAN
a) Access to the shared folder on the LAN can be obtained by starting File Explorer and 

selecting the Network location.
The desired computer is selected from the ones found in the network and the desired folder 

is accessed. 

Fig.5. Share
The folder can also be accessed by typing the network path to it (name of a computer) 

FolderToShare – and with the IP address of the computer.

Fig. 6. Share
b) After accessing the folder, its contents can be copied in the standard way or modified/deleted,  

if allowed.

2. Using a network printer – to be able to use a printer on a LAN, it must be installed 
on a computer connected to the network and be shared, or the printer has a network card with 
which to connect directly to the LAN.

Printer sharing goes through the following steps:
a) Use the sequence of Control Panel/Devices and Printers commands to access the printers 

installed on the computer. Right-click on the desired printer to open the context menu and select 
the Printer properties option. 

b) The Sharing tab is selected. Check Share this printer and enter a name by which the printer 
will be available on the network. Confirm with the OK button.
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Using a shared LAN printer
To use a shared printer, you must install the appropriate network driver for that printer. If the 

printer is no longer installed, follow these steps:
a) File Explorer starts and the Network location is selected.
b) Select the computer from which the printer is shared and double-click the printer icon 

using the left mouse button. Wait for the driver to install. If the installation was successful, the 
printer should appear in Control Panel (Devices and Printers).

The installed printer is used in the standard way by any print-enabled application.

3. Additional network settings – for the proper functioning of the network and all 
shared devices it is necessary to open the Control Panel (Network and Internet / Network and 
Sharing Center) Change advanced sharing settings and mark the following options:

a) Turn on network discovery – allows the discovery of computers connected to the local 
network.

b) Turn on file and printer sharing – enables the process of sharing resources.
c) Turn on password protected sharing – this option requires a username and a password to 

access the resources.

Fig. 7

Fig. 8
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Fig. 9

Fig. 10
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Fig. 11

Questions and tasks
1. Create a Test folder on your computer. Share the folder with the Everyone group and set 

full access rights to it.
2. Teamwork skills – try to access the folder shared by your classmate. Create a text 

document in it and save it.
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The rapid development and improvement of computer networks and network services leads 
to the need to securely protect data from loss or misuse. 

1. Hardware damage – can be a serious cause of information loss. Taking certain 
protection measures is not only necessary but also mandatory.

• Use of emergency power supply to avoid power supply problems. The most common 
option is to use battery-powered UPSs that can provide system uptime after a power 
outage.

• Data backup – special backup programs are used, and in case of hard drive damage or 
virus problem the information can be restored. It is a prerequisite that the archived data 
is stored on an additional device.

2. Network security - this is the main problem when using a computer network. There 
are many cases of unauthorized intrusion into the networks of various governmental and business 
organizations. There are also serious attacks with computer viruses. 

a) external threats – occur when the local network is connected to another network, such as 
the Internet.

• unauthorized use of external usernames and passwords - each user of the resources of a 
system receives an account – a username and a password. Using an external account to 
access system resources is a prerequisite for security breaches. Each authorized user is 
responsible for the protection and use of the login data provided to him. There are also 
many ways to guess and crack external passwords.

• denial-of-service attacks – these attacks do not cause a system crash but flood the 
network with unnecessary data packets or simulate a network problem. In both cases, the 
established connection is interrupted (or it becomes impossible to establish such) and the 
communication stops until the problem is eliminated.

• IP spoofing - this type of attack changes the sender's IP address, and it appears that the 
data was sent from a secure source. The recipient does not know this and directs the 
accepted requests to the receiving host. DoS attacks use this method to overload the 
network.

• computer viruses and worms – self-replicating programs that spread from one computer 
system to another by attaching their code to various files without the user's knowledge 
and consent. Some of them are harmless – they only write an annoying message, for 
example, but others are aimed at stealing or destroying files.

A worm is a virus that uses the web to spread to end devices. It does not need to be attached 
to an existing program but is distributed as an attachment to an e-mail, HTML page and more.

• Trojans – malicious programs that present themselves as useful software. The purpose is 
to gather important information for the attacked user or to cause a security breach of the 
attacked system.

b) internal threats – can be carried out directly on the computer system or by breaking into 
the local network. The motives can be corporate espionage, dissatisfied employees and others.

14. proteCtIng InformatIon In a network 
envIronment
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3. Security measures
• use of operating systems with a high degree of security - all modern OSes meet this 

requirement. It is also important to regularly update the used OS and software applications. 
Updates released by the software vendor often close possible security breaches.

• authentication and identification – user authentication process. For this purpose, different 
identifiers are used – a password, a PIN code, a cryptographic key, an electronic signature, 
etc.

• data encryption – encryption uses a key to shuffle (encrypt) and then arrange (decrypt) 
the data in order to recover it. Special algorithms are used.

• use of Firewall and proxy server – the firewall is a filter of incoming and outgoing data 
packets. Depending on the settings made, the passage of a packet is allowed or prohibited.

The proxy server serves as an intermediary between the internal network and the computer 
systems of the external network.

• Use of antivirus software – modern antivirus programs monitor real-time virus infections, 
report them, and try to neutralize them. Again, it is important to keep our antivirus 
program up to date with information about the latest viruses.

• Restriction of physical access – servers and communication devices must be located in 
areas without access by individuals, except for those authorized to do so.

4. Basic methods and means of network protection
a) maintenance of users with different levels of access - the level of access of a user determines 

what data he has access to and what actions he can perform with them. There are two types of 
accounts available in Windows 10:

• Administrator – allows full control over the computer and access to all programs, settings 
and data.

• Standard – allows the user to use software and make changes that do not affect other 
users or system security.

b) Tips for use of secure passwords:
• not to use words or numbers, which due to the connection with the user can be easily 

guessed (name, surname, date of birth, etc.).
• easy for the user to remember so that it does not have to be recorded.
• use of lowercase and uppercase letters, numbers and special symbols.
• longer password length.
• change the password over a period of time, and the new password should not look like 

the old one.
• use of specialized software – password manager – allows you to set a long and complex 

password (random sequence of characters) for each user's account. These passwords are 
stored in encrypted form and the only password the user needs to remember is that of the 
password manager itself.

• file encryption – encrypts the file and the contents cannot be read by another. In Windows 
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10, this is done through the following steps: Properties (Advanced) Encrypt contents to 
secure data.

• use of electronic signature.
• e-mail security – it is recommended when receiving and/or sending messages via e-mail 

to provide a connection via encryption protocols (https). Other recommended tips are not 
to open e-mails without a sender and to ignore messages that contain only hyperlinks.

• maintaining up-to-date versions of software products.
• controlling access to the network through firewalls.

5. Set permissions on LAN resources in Windows 10
As we have already seen when sharing resources on a local network in Windows 10, a level 

of permission is set between the options Read – read only and Read/Write – read, modify and 
delete.

Fig. 1. Protection
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The sharing of a resource (folder) can also be done by performing the following steps – Fig. 1: 
1. Right-click on the selected folder and select Properties from the context menu.
2. In the open window select the Sharing tab.
3. Click the Advanced Sharing button.
4. Check the Share this folder option and specify the name with which the folder is shared.
5. The Permissions button sets the group or individual user with whom the folder is shared.
6. Check the desired modification options in the Allow column. The options are as follows:
• Read – allows you to see the names of folders, files and their attributes, run programs 

and copy files.
• Change – it allows everything from Read plus the ability to create folders, add files, 

change the contents of files, delete files and folders.
• Full Control – it includes all the options from Change plus the ability to change the 

allowed actions with files and change the ownership of a file.

Questions and tasks
1. What are the risks of working in a network environment?
2. List some external security threats in a network environment?
3. What does data encryption mean?
4. What is the role of firewalls?
5. Specify ways and means to protect the network from unauthorized access.
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1. eGovernment: http://ec.europa.eu/egovernment
a) sites of state institutions – the state institutions are institutions performing the functions of 

the state according to the constitution and the laws.
According to the Constitution of the Republic of Bulgaria, the head of state is the President:
• President of the Republic of Bulgaria - www.president.bg 
The authorities are divided into three - legislative (National Assembly), executive (Council 

of Ministers) and judicial (Supreme Judicial Council). These three authorities are independent of 
each other.

• National Assembly – www.parliament.bg 
• Council of Ministers – www.government.bg 
• Supreme Judicial Council – www.vss.justice.bg 
Other important institutions:
• Ministry of Education and Science – www.mon.bg 
• Ministry of Interior – www.mvr.bg 
• Constitutional Court – www.constcourt.bg 
• State Agency for Child Protection – www.sacp.government.bg 
b) e-government – a term that refers to the use of information and communication technologies 

to provide services and information to citizens, businesses and other organizations. In Bulgaria, 
the State Agency for Electronic Government is responsible for e-government - www.egov.bg. 

Some of the institutions in Bulgaria that offer electronic services are:
• National Revenue Agency (NRA) – www.nra.bg 
• National Social Security Institute (NSSI) – www.noi.bg 
• National Health Insurance Fund (NHIF) – www.nhif.bg 
• Trade register – www.brra.bg 
• Sites of municipal administrations

2. E-commerce
E-commerce or online commerce is the buying and selling of products and services through 

the use of electronic systems such as the Internet.
Principles:
• E-commerce is done online.
• Special sites called e-shops are used.
• The e-shop is constantly open and provides easy access to information about the products 

and services offered.
• There is no limit to the number of products and services sold.
• Every user with Internet access also has access to the e-shop.
• The order of products is done by filling in a form, which indicates the type and quantity 

of the desired products, delivery information, method of payment and more.
• Payment can be made by bank transfer, using a debit or credit card or cash on delivery  

(payment on delivery).

15. InformatIon and servICes for CItIzens 
on the Internet. e-CommerCe
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The advantages of e-commerce are that we have easy access to a large number of goods 
and services offered on the Internet, we can shop from around the world, easily find what we are 
looking for, the goods are delivered to our home.

The main disadvantage is that we can come across unscrupulous traders and be deceived. 
Another disadvantage is that the consumer does not actually see the product he orders and relies 
on photos and/or video material provided by the merchant in the e-shop.

3. Electronic money – is a monetary value stored and transferred as electronic information 
on various electronic devices.

Electronic money can be centralized when there is central control over its supply or decentralized 
when there is none. Decentralized electronic money is also known as a digital currency. The most 
well-known decentralized electronic money is cryptocurrencies, such as bitcoin.

Electronic money can only be exchanged electronically.
Main characteristics:
1. They represent monetary value through the debt of their issuer.
2. Can be stored on electronic devices.
3. They are guaranteed by legally recognized means of exchange, i.e. the money issued by 

the central bank of the country.
4. They include a mechanism for prepayment of the value.
5. They are convertible into central bank money.
6. They can be used for payments not only with their issuer.
7. Electronic money is stored in accounts with a higher degree of cybersecurity.
8. They can be sent to other licensed financial institutions around the world.

4. Law regulations
• Electronic Commerce Law
• Law on consumer protection 
• Law on the provision of financial services at a distance
• Electronic Communications Law
• Electronic Document and Electronic Signature Law
• Directive 2000/31/ EC – electronic commerce in the EU
• Directive 2000/46/EC of the European Parliament and of the Council of September 18th, 

2000 on the taking up, pursuit of and prudential supervision of the business of electronic 
money institutions

• Regulation (EU) (910/2014 of 23 July 2014 on electronic identification and certification 
services for electronic transactions in the internal market

• General Data Protection Regulation (EU) 2016/679
• Law on Personal Data Protection
• Law on Protection of Copyright and Related Rights
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Glossary:
• E-government – a term that refers to the use of information and communication 

technologies to provide services and information to citizens, businesses and other 
organizations.

• E-commerce – the buying and selling of products and services through the use of 
electronic systems such as the Internet.

• E-money – a monetary value stored and transferred as electronic information on various 
electronic devices.

Questions and tasks
1. Do a survey on the Internet and write down what an electronic signature is and what its 

benefits are.
2. What are the main similarities and differences between traditional and electronic money?
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1. Templates
Template is a pre-formed document that is used in the preparation of multiple identical 

documents. The template can be a birthday card, an invitation, a business card, a calendar, a 
resume and more. The Microsoft Word text editor offers a choice of ready-made templates that can 
be changed according to the user's needs. In addition to ready-made templates, you can save your 
own template. In this text editor, templates are saved with a .dot, .dotx, or .dotm extension.

2. Using a ready template
Newer versions of Microsoft Word allow you to choose ready-made templates to use when 

developing your documents. Upon starting the text editor, you can select the needed template, and 
the most commonly used is a blank form. You can see the initial template selection window in Fig. 1.

Fig. 1. Templates
If necessary, you can use the search engine (Fig. 2) to find the required template.

Fig. 2. Templates
If you need to make a party invitation and want to see the different template options, type 

‘party’ in the search engine and press Enter (Fig. 3). You can see the results in Fig. 4.

Fig. 3. Templates

16. templates and themes In a text doCument

III. applICatIons



66

Fig. 4. Templates
After selecting the template, a window opens where you need to confirm the selection (Fig. 5).  

Select the Create button.

Fig. 5. Templates
After confirmation the document is loaded and you can now edit the content. Еditing is the 

same as for any other document. If necessary, you can replace the content (Fig. 6).

Fig. 6. Templates
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3. Saving a template 
If you have created a template that you want to save and use in the future, you can save it in 

the custom Office Templates directory. To store it there, you need to follow these steps:
1. From the File menu Select Save As (Fig. 7)

Fig. 7. Templates
2. Depending on the version of the office suite you use, there are two options: 
• open the storage window directly.
• you must press the browse button to reach the window. 
3. In the storage window, name your template and select Word Template as the file type  

(Fig. 8). After selecting this format, the default directory opens. 

Fig. 8. Templates
4. Using themes
The themes you can use are in the Design menu (Fig. 9).
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Fig. 9. Templates

They help you customize the look of your template. With the help of a theme, you can 
determine what each element of your document should look like (titles, figures, text, graphics, 
images, etc.) or change the color gamut (Fig. 10).

Fig. 10. Templates

Tasks:
1. Create a text document that can be used to present yourself (e.g., your CV, etc.) – 

education, interests, skills, and more. Use the template named Blue spheres resume. Add 
your photo and the information.

2. Select the appropriate template to create an invitation for an event of your choice. Save 
the created invitation with the name invitation.dotx.
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17. sort data In a spreadsheet

Sorting means to sort data in a desired sequence. Only a list can be sorted. The list is a table 
that must meet the following conditions:

• The first row in the table must contain headers (heading row or column).
• The data in one column must be of the same type.
• The data in one line must be interconnected.
To be able to recognize the list correctly (List rule): 
• The list must be pre-separated with a blank line and a column from the rest of the data 

in the sheet.
• Headers must be written on one line (No cell merging).
• No summary lines - Sum, Min, Max, etc. below the table.
Task 1: Open the file NVO-10klas.xlsx and sort data by age in descending order, and within 

the age the list should be sorted by name in alphabetical order.
List sorting:
1. Select a cell from the list that we want to Sort.
2. Select the Sort button from the Data menu, from the Sort & Filter panel (Fig. 1).

Fig. 1. Sort
3. The Sort dialog box opens (Fig. 2).

Fig. 2. Sort
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Fig. 3. Sort
• In Sort by we see the columns, but not with their names, which means that the list is not 

recognized => We should apply the list rule (Separate the title from the table with an 
empty row – Add a row above the table). 

• Again Data/Sort – The Sort dialog box opens (Fig. 3)
• From Sort by we choose the first criterion by which we will sort – Age.
• From Sort On – value, cell or font color, or icon. The most common option is Values.
• From Order – set the sort order – ascending, descending, alphabetical.
• Add Level – we add more criteria – as in our task, the second criterion must be Names.
• My data has headers – When checked, the header row does not participate in the sort.
• Delete Level – deletes the specified criterion.

Tricks:
When sorting, Excel does not distinguish between lowercase and uppercase letters. If this 

distinction is necessary - we should use Data/Sort/Options… – Case sensitive option – Fig.4.

Fig. 4. Sort
In addition to columns, Excel can also sort by rows. This can be done by using the  

Data/Sort/Options… – Sort.



71

18. spreadsheet data fIlterIng

 Spreadsheet filtering provides the ability to see only part of the data that meets certain 
conditions (criteria) predefined by the user, and the rest of the data is temporarily hidden. It is 
performed from the Sort & Filter panel of the Data menu.

There are two types of filtering:
• Auto Filter 
• Advanced Filter

1. Auto Filter 
1. Select a cell from the list, that we want to filter.
2. Select the Filter button from the Data menu, from the Sort & Filter panel (Fig. 1).

Fig. 1. Filter
3. In each header cell (cells in the title line) arrows appear. (Fig. 2).

Fig. 2. Filter

Click on the arrow of the corresponding header cell, a drop-down menu is displayed, and 
we apply the desired filter (Fig. 3). The drop-down menu contains a list of all values from the 
corresponding column. If the table is larger, this list will be large too. It is extremely difficult to 
look for values in it. Therefore, we can use the following options:

• Number Filters for numeric data.
• Text Filters for text data.
• Date Filter for dates.
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Fig. 3. Filter
All three options include Custom List – it allows you to define up to two conditions related 

to the logical AND and OR.
After filtering, a funnel appears in the name of the header cell. The connection between the 

individual filtered fields is of type “AND” – these data (records) are visualized, that meet all the 
criteria that are set. The Status Bar displays the number of filtered records.

Cancelling filtered records:
• From the already filtered field:

 ) putting a check mark on Select All cancels one filter.
 ) when selecting Clear Filter from we cancel one filter.

• Clear button from the Data menu, from the Sort & Filter panel – removes all filters at 
once, but keeps the arrows in the header cells.

• Filter button from the Data menu, from the Sort & Filter panel – completely removes 
filtering (removes arrows from header cells).

Task 1: Open the file NVO-10klas-Filter.xlsx and extract data only about students who have 
scored less than 10 points on NEE 10th grade.

In a cell in the list, select Data / Filter. In the header cell “Result in points”, select Number 
Filters / Less Than … The Custom Auto Filter dialog box opens (Fig. 4). In the right field enter 10.
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Fig. 4. Filter 
Task 2: Open the file NVO-10klas-Filter.xlsx and extract data only about students who have 

scored less than 10 points and more than 48 points on NEE 10th grade.
In a cell in the list, select Data/Filter. In the header cell “Result in points”, select Number 

Filters/Custom Filter ... The Custom Auto Filter dialog box opens (Fig. 4). 
• In the first row on the left we enter is less than and on the right field we enter 10. 
• In the second row on the left we enter is greater than and in the right field – 48 
Both conditions are connected with the logical “OR” (records must meet either criterion). 

The other possible choice is “AND” (simultaneous fulfilment of both criteria).
As a result, the data is shuffled, so we can now sort it – for example in descending order (Sort 

Largest to Smallest).

2. Advanced Filter (from the Data menu, from the Sort & Filter panel) 
Preparation: Before running Advanced Filter, we need to create a small help table - Criteria 

range. We need to position it so as not to violate the list rule – to leave at least one blank row or 
column of other data. 

Criterion consists of at least 2 lines:
• Header – must match the header from the list (copy it).
• Value – set the specific condition or value:

 ) If the data is written on one line, then the connection between them is “AND”.
 ) If the data is on different rows, then the connection between them is “OR”.

Realization:
a. Select a cell from the list, that we want to filter.
b. Select the Filter button from the Data menu, from the Sort & Filter panel (Fig. 5).
c. The Advanced Filter dialog box opens (Fig. 6):
• Action – Filter the list, in-place or Copy to another location.
• List range – Excel marks the whole list by default, otherwise - we mark it.
• Criteria range – we mark the small auxiliary table (criterion) that we have prepared.
• Copy to – select a cell from which the filtered list will be displayed (an empty cell 

selected in such a way so as not to violate the list rule). If we do not want to see all the 
columns in the list, we can create a second additional table in advance. It consists of one 
row, only of headers and the columns we want to see. Then on the option Copy to, we 
mark the second additional table.
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Fig. 5. Filter

Fig. 6. Filter

Task 3: Open the file NVO-10klas-Filter.xlsx and extract information (make a reference) 
only about students Alex and Daniel, who are from Varna.

First, we create the auxiliary table (criterion). Since it consists of at least 2 lines – a header 
and a value, we copy the header, in whose column are Alex and Daniel – “Name”, for value – we 
put “Alex” under Name. 

The question is where to put Daniel? We define it according to the connecting union – “AND” 
(on the same line), “OR” (on different lines). Do we consider if one person can be called Alex and 
Daniel at the same time? The answer is no, therefore they are on different lines (one below the 
other). 

Along with the name, we want them both to be from Varna. On the line of the header “Name” 
the header “City” is copied and as a value (below it) “VARNA” is copied. But even this is not 
enough, because it will bring us information about Alex from Varna and about Daniel, regardless 
which city the latter comes from. In order to fix only for Daniel from Varna, once again, I have to 
copy “VARNA”. The exact criterion (Fig. 7).
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Fig. 7. Filter
There is no information about Daniel from Varna in the filtered table, but there is information 

about Alexandra, whose name contains Alex. 
To fix only Alex to appear, the criterion is the following: = ”= Alex”

Tricks:
With Auto Filter, entries can be filtered either by value or by color, but not simultaneously.
Filter by Color is possible only if we have the following for the column in which we will 

apply it: records (rows) with changed color of the symbols (by Font Color), background color (by 
Cell Color) or icons (by Cell Icon).

In advanced filtering, the criterion can be comparative (the examples discussed so far) or 
computational. Extract information about students who have above average points.

Instructions: 1. The header must be different from the one in the list or remain blank, but 
don't forget to mark it in the Criteria range.

Instructions: 2. The value = I3> average ($ I $ 3: $ I $ 94), where I3 is the first cell with a 
value from the “Result in points” column. We use “$” to fix the search area.

Tasks:
1.Open the file NVO-10klas-Filter.xlsx, do the tasks with Auto Filter and Advanced Filter.
1.1.Extract information about the students from Sofia with a score between 40 and 50 points.
1.2.Open the file NVO-10klas-Filter.xlsx and extract data only for students who have scored 

less than 10 points and more than 48 points on NEE 10th grade.
1.3.Get information about students Alex and Daniel.
1.4.Get information about the students from First language school and St. Kliment Ohridski 

high school, who have 50 points.
1.5.Extract information about students of this age, which is presented in the table in red.
Instructions: Use Filter by Color for the Age header
1.6.Extract information about the results of NEE 10th grade only for high schools.
Instructions: High schools have the word “high” before their names.
2.Open the file NVO-10klas-Filter.xlsx, do the tasks with Auto Filter and Advanced Filter
2.1. Get information about the first two students with the highest score in math.
Instructions: Number Filters / Top 10. A dialog box opens, and we type 2. 
2.2. Get information about the results from NEE 10th grade of students from Varna who have 

taken the Bulgarian language and literature exam and their result is below average.
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Validation is:
• A function that allows you to set data limits as soon as you enter a cell.
• Does not allow incorrect data to be entered.
Sequence of actions:

1. First way of applying validation
• We select the area of cells for which we want to set a condition for data validity.
• Execute command Data Validation from the Data menu from the panel Data Tools  

(Data / Data Tools / Data Validation) (Fig. 1).

Fig. 1. Validation

2. Second way of applying validation
• Apply Data Validation per 1 cell – Data Validation from the Data menu from the Data 

Tools panel (Data / Data Tools / Data Validation) (Fig. 1).
• Multiplies as a function – in the lower right corner, getting a small black plus, hold the 

left mouse button and drag.
As a result, the Data Validation dialog opens (Fig. 2). There are 3 pages:
• Settings - condition for validation (correctness) of the data.
• Input Message – prompt message.
• Error Alert – error message.

Fig. 2. Validation

19. valIdatIon of data In a spreadsheet
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When List is selected:
• Data is entered using a drop-down list in a cell. 
• The Source field is used to fill in the data in the drop-down list. There are 2 ways:

 ) Direct input in the field Source (Fig. 3) - as the values are separated by a semicolon 
or only a comma (Question of settings). As a result, the values one below the other (Fig. 4.1) 
should be obtained, and not one line (Fig. 4.2).

Fig. 3. Validation 

 ) Pre-input into randomly selected cells (Fig. 5) and here only the area (Fig. 6) is 
marked.

Settings page – we set a condition for data validation
Allow – determines what type of data 

is allowed to enter Data – sets the restrictive conditions

any value between 

whole number not between 

decimal equal to

list not equal to 

date greater than 

time less than 

text length greater than or equal to 

custom less than or equal to 
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Fig. 6. Validation

• Input Message Page:
• A prompt message is created when entering data.
• Indication of what should be entered as a value in the cell.
• Appears when a cell is selected to enter data into it.
• Error Alert page:
• An error message is generated.
• There are three types (Fig. 7):

 ) Stop - forbids entering invalid data. There are options: Try again, Cancel and Help.
 ) Warning/Information - warn that the data is incorrect without restricting its input.

Fig. 7. Validation 

Fig. 4.1. Validation Fig.4.2. Validation Fig. 5. Validation
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Task 1: Open the file NVO-10klas-Validation.xlsx Add a new column – sex. Set a condition 
for the validity of the data in the sex column with two options – male and female. 

1. We add a new column. We will work in the second way.
2. Select the first cell under the header.
3. Data / Data Validation / Data Validation (Fig. 1).
4. In Settings select List (Fig. 2).
5. In Source enter man; woman (Fig. 3).
6. The result is (Fig. 4.1).
7. We multiply as a formula.

Task 2: Open the file NVO-10klas-Validation.xlsx Set a condition for the validity of the data 
in the age column so that an integer is entered in the interval 13 through 60. Set a help message 
and an error message.

Enter an age between 13 and 60.
Enter the correct age - an integer between 13 and 60.
1. We will work the first way:
2. We mark the area J3: J94
3. Data / Data Validation / Data Validation (Fig. 1)
4. In Settings - select Whole number (Fig. 2)
5. We choose between Min - 13, Max - 60 (Fig. 8)
6. Help message and error message.
• Data / Data Validation / Data Validation - Input Message (Fig. 9). After positioning a cell 

in the age column, a hint is displayed (Fig. 11).
• Data / Data Validation / Data Validation - Error Alert (Fig. 10)

Fig. 8. Validation
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Fig. 9. Validation

Fig. 10. Validation

Fig. 11. Validation
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The functions in MS Excel are divided into certain categories (Fig. 1). If we do not know 
in which category the required function is, we use Insert Function (Fig. 2). The dialog box opens 
(Fig. 3). 

1. If we know how to write the function – write it in the Search for a function field and 
select the Go button. 

2. If we know which category it is in, we choose the appropriate category. 
3. If we do not know in which category the function is, we choose All. If we do not know 

how to write the function, we click in the field Select a function, and with the first letter 
of the function (example Sumif) – key “S”, we press so many times until the desired 
function appears.

Fig. 1. Techniques 

Fig. 2. Techniques 

Fig. 3. Techniques 

20. spreadsheet CalCulatIon teChnIques
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Let's remember:

Logical function if

Checks a certain logical condition (Fig. 4). There are 3 arguments:
• Condition.
• Value under fulfilled condition.
• Value under unfulfilled condition.
For example: = IF (D2> 1.5; “Yes”; “No”).
Another function, which is selected from the Name box (Fig.2, the field in which is written 

B4), can be put in the place of each argument.

Fig. 4. Techniques 
Basic statistical functions (Statistical category) are min, max, average, count. This category 

also includes: sumif and countif.

Countif function

• Counts the cells in a given area that meet a given criterion.
• There are 2 arguments:

 ) Search area (Where are we looking for?).
 ) Criterion (What are we looking for?).

• = countif (Range; Criteria) (Fig. 5)
Task 1: Open the Mileage-Car.xlsx file and find how many cars have achieved mileage 68.
1. Select the Insert Function button (Fig. 2).
2. We select the function countif from the category Statistical or All.
3. The Function Argument dialog window opens (Fig. 5).
• Range - where can we find the criterion (mark an entire column).
• Criteria - the criterion is set, in this case 68

 ) By direct input – 68 (Fig. 5).
 ) By the address of the cell that contains it - G14.

4 must be written in the marked box.
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Fig. 5. Techniques 

Sumif function
• Sums values of cells in a given area that meet a certain criterion.
• There are 3 arguments:

 ) Search area (Where are we looking for?)
 ) Condition - criterion (What are we looking for?)
 ) Summation area (If it meets the criterion of what to add)

• = sumif (Range; Criteria; Sum_range) (Fig. 6)
Task 2: Open the file Mileage-Car.xlsx and calculate the total mileage of the cars that were 

produced in 2015. 
Similar to the countif function. 
• The last argument specifies what we will sum up - we mark the cells in the Mileage 

column. (Fig. 6)
As a result, 2086 must be written in the cell.

Fig. 6. Techniques 
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The criterion
• Can be set as a value or as a cell (Example - G14).
• The text can be written, but then put in quotes ("Opel"). It must be spelled correctly, with 

full compliance)
= COUNTIF (B3: B74; “Opel”)
• May contain characters: 

 )  <, >, =, <=, >=
 ) <> - different

= COUNTIF (B3: B74; “<> Opel”)
“” - when the cell is empty.

Fig. 7. Techniques 
Tasks:
1.Open the Mileage-Car.xlsx file.
1.1. Find how many cars have run over 100.
1.2. Find how many cars have run over 50.
1.3. Calculate the total mileage for 2015, 2016 and 2017.
Directions: Create a new table within the worksheet (Fig. 7). It is not necessary to consider 

each year separately. For this purpose, in the formula, where we have an area (Range and Sum_
range) the values are set with absolute addresses in order to use the property of copying formulas. 
Thus, the formula is written only on the first line and multiplied.

1.4. Calculate the total mileage realized by the cars for the previous day
Directions: Use today's function -1.
1.5.Calculate the total mileage for cars manufactured before 2015.
1.6.Calculate the total mileage of Ford cars.

Tricks:
Wildcards can be used to form the criterion.
Task 1: Calculate the total mileage realized by cars with a brand starting with “F”.
Task 2: Calculate the total mileage achieved by cars with the last letter ”a“.
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Task 1: Make a lexicon in Excel. Set restrictive input conditions, a prompt message, and 
an error message. Save it with the name Leksikon. Share it with your classmates and have them 
complete it. There must be at least 20 records.

Directions may contain columns: Name, age (integer from 7 to 70), date of birth (integer 
from 1 to 31), zodiac sign (drop-down list of zodiac signs), GSM (length 10), favorite subject 
(drop-down list of 10 studied subjects), favorite season (drop-down list of seasons), etc.

Task 2: Open the Leksikon.xlsx file that you have created in Task 1. Sort information:
1. By zodiac signs in alphabetical order.
2. By zodiac signs and by age in ascending order.
3. By zodiac sign and by any favorite subject.
4. By seasons in the following sequence: summer, spring, autumn, winter.
Task 3: Open the Leksikon.xlsx file that you have created in Task 1. Use the function to find 

how many of those who have filled in the lexicon have a favorite season summer, spring, winter.
Directions Create an additional table (Fig. 1). The formula does not need to be written on 

every line. It must be written in a way that once written, we can multiply it for the other lines.

Fig. 1. Exercise 
Task 4: Open the Leksikon.xlsx file that you have created in Task 1. Refer to:
1. Only people born under Cancer zodiac sign.
2. People born under Cancer and Leo.
3. People who are born under Cancer and Leo and their favorite season is summer.
 

21. spreadsheet exerCIse
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22. form letters

Form letter
A form letter is a document that has a permanent part and a part that changes. The permanent 

part is used as a pre-created template, and the changing part is taken from a second document 
(data source document). Such documents are used when you need to send the same content to 
many people and it needs to be addressed individually, i.e. we change the name, surname, address 
or something else. In the form letter, we use two files – the first is our template with the text, 
which is intended for everyone, and the second is a table containing individual information about 
the people to whom the letter will be sent (it contains all the information that will be changed). 
Another purpose may be to create invitations, certificates or other documents that are intended for 
many people. 

Creating a form letter 
There are small differences in the creation of a form document with different versions of 

office suites. There are two ways of creating such a document:
I. The first way is to use a creation wizard. We have the following actions with it 
1. We open the menu Mailings.
2. Select the Start Mail Merge button.
3. From the possible options, we choose Step-by-Step Mail Merge Wizard.

Fig. 1. Form letters
4. After starting the Step-by-Step Mail Merge Wizard in the main document opens an 

additional window that allows you to create your document following the steps.
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II. The second way also has a few steps: 
1. We create the main document (template) - this is the main text that does not change (Fig. 3).
2. We create the data source file (this file can be created from the document itself or in another 

standalone document). Fig. 4 shows an Excel file that will be used to create the form document. 

Fig. 4. Form letters

Fig. 2. Form letters

Fig. 3. Form letters
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3. We link the data source file and our main document:
• We open the menu Mailings.
• Select the button Select Recipients (Fig. 5).

Fig. 5. Form_letters
• If you use an existing document, select the option Use an Existing List and a window 

opens which allows you to select the finished document (Fig. 6).

Fig. 6. Form letters
• If you do not have a document ready to use, select the Type a New List option. A 

window opens that allows you to create a table (Fig. 7)
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Fig. 7. Form letters

4. We indicate the places where the variable information will be generated.
When you add or create a data source document in the Mailings menu, the Insert Merge 

Field menu becomes active (Fig. 8). 

Fig. 8. Form letters
There you can see all the column names in your data source table (Fig. 9). 

Fig. 9. Form letters
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Place the cursor where you want to insert the information field and select the name of the 
corresponding column (Fig. 10). 

Fig. 10. Form letters
In the example, we place the fields in place of the red dots (Fig. 11).

Fig. 11. Form letters
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When you insert a field that will be replaced with information in the main document, it is 
surrounded by V-shaped arrows (<<column_name>>). They are not displayed when generating the 
document but only indicate from which column the information will be displayed.

Generating letters
After creating the form document, you can view the created records one by one by enabling 

the Preview Results option from the Mailings menu (Fig. 12).

Fig. 12. Form letters
You can view the different entries using the control arrows (Fig. 13).

Fig. 13. Form letters
You can generate all the letters in a new file. Each letter is generated on a different page of 

the document. This is done from the menu Mailings and the option Finish & Merge (Fig. 14).
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Fig. 14. Form letters
Tasks:
1. In a text document, create a form letter notifying the school principal of the student 

enrollment. Use the sample letter in Fig. 3. To fill in the form document, use the 
information in Fig. 4.

2. Use the invitation.docx file you created in the template theme. Create a table with the 
names of 10 of your friends. Use a form document to customize the invitation for each 
of your friends.
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23. CreatIng an envelope

Creating a table for a form document
In the previous lesson, we learned how to add information from an existing file. To create a 

table in the text document itself, you must follow these steps:
1. Open the menu Mailings.
2. Select the Select Recipients button.
3. Select the option Type a New List (Fig. 1).

Fig. 1. Envelopes
4. A window opens that allows you to create a table (Fig. 2).

Fig. 2. Envelopes
On the first row are the names of sample columns that you can use. To change the names 

or number of these columns, select the button Customize Columns, which opens a new window 
where changes can be made (Fig. 3).
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Fig. 3. Envelopes
It allows you to delete, add, rename, or rearrange the column sequence. After customizing 

the columns, you go back to the main window of Fig. 2. The filling in is done by having one record 
on each line. Use the New Entry button to add a new entry and the Delete Entry button to delete 
an entry.

5. After creating the table, save it by clicking on the OK button.
6. A new window opens (Fig. 4) that asks you to name the table and select a folder to save it 

(the table is saved as an access file).

Fig. 4. Envelopes
7. After selecting the name and folder and pressing the Save button, in the Mailings menu 

the button Insert Merge Field becomes active. The process continues in the same way as when 
adding an information file. 
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Creating an envelope
Creating an envelope is one of the options when creating form documents. In addition to 

issuing diplomas, badges, labels, making a birthday invitation or sending a letter, you can also 
customize the envelope for the recipient. Creating an envelope is done in the following steps:

1. Open a blank Word document.
2. Open the menu Mailings.
3. Select the Start Mail Merge button and the option Envelopes (Fig. 5).

Fig. 5. Envelopes
4. A new settings dialog opens, which you can see in Fig. 6.

Fig. 6. Envelopes



96

In this window, you set the dimensions you want for the envelope, the default size is 6 3/4. In 
addition to the size, you can also adjust the printing options. After selecting the size, the worksheet 
is adjusted automatically and is ready to be used (Fig. 7).

Fig. 7. Envelopes
5. The easiest way to place information is to use text boxes. They are added from the menu 

Insert and the button Text Box (Fig. 8).

Fig. 8. Envelopes
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6. Fill in the sender's information, create a table for recipients by following the steps from 
Create a table for a form document. An example of the final result can be seen in Fig. 9.

Fig. 9. Envelopes

Tasks:
1. Create an envelope that can be used to send the notification letters you already created in 

the previous lesson. Use the information in Envelopes-list.xlsx or from Fig.10 – envelopes.

Fig. 10. Envelopes
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24. templates and form letters exerCIse

Task 1 
Use a template and create a form diploma document for seven of your classmates who took 

part in a math competition. The diploma must include the names of the student, the number of 
points received and the place where he/she has qualified.

Create a label
From the Mailings menu, the Start Mail Merge option - allows you to create a mail envelope, 

business card, label or other in addition to a form letter (Fig. 1). 

Fig. 1. Exercise
Selecting the Labels option opens a new dialog box that allows you to make additional 

settings and layout (Fig. 2). 

Fig. 2. Exercise
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From the New Label button, you can adjust the size of the labels you want to create (Fig. 3). 

Fig. 3. Exercise
For the label, you can adjust the size of the margins, the height and width of the label as well 

as the number of labels per page. When using a form document when creating a label, you only 
need to format the first one, and then use the Update Labels button (Fig. 4).

Fig. 4. Exercise
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Task 2
For your school open day, you need to create badges for students who will guide visitors. 

Create a suitable design (select appropriate text, font, and color layout). Fill in the information 
about the badges with the help of a form document. The necessary information can be found in 
List.xlsx or in Fig. 5.

Fig. 5. Exercise
 



101

Form 
The form is a special document that has special fields to fill in. It is used to gather information. 

They can be created both in a text editor or online. There are different platforms that allow you to 
create a form.

• Microsoft Word allows you to create a form through the developer menu. Special fields 
are added using controls. 

• An example of a platform that can create an online form is Google form.

Form in Microsoft office 
When creating a form using Word, you must first turn on the developer menu. To do this, 

follow these steps:
1. Select the File menu (Fig. 1).

Fig. 1. Forms

2. From the File menu, select Options (Fig. 2).

25. forms

Fig. 2. Forms
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3. In the window that opens, select Customize Ribbon (Fig. 3)=

Fig. 3. Forms
4. From the options for Main Tabs you need to include the Developer menu (Fig. 4).

Fig. 4. Forms
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After completing these steps, you will now see the Developer menu in the menu bar (Fig. 5). 
All the controls needed to create a form are located here (Fig. 6). Controls are graphical objects 
that receive or display data. 

Fig. 5. Forms

Fig. 6. Forms
• Types of Microsoft Word controls:
• Rich Text Content Control 
• Plain Text Content Control 
• Picture Content Control 
• Building Block Gallery Content Control 
• Check Box Content Control 
• Combo Box Content Control 
• Drop-Down List Content Control 
• Data Picker Content Control
To add a control, you must first turn on Design Mode (Fig. 7) and place the cursor where 

you want to insert it and click on the selected control. The chosen control is automatically placed 
where the cursor is located (Fig. 8).

Fig. 7. Forms
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Fig. 8. Forms

Control settings
Additional settings of the controls are made by selecting the Properties option (Fig. 9). An 

additional dialog box opens, which has individual settings for each control (Fig. 10). 

Fig. 9. Forms

Fig. 10. Forms
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• In the Plain Text Content Control, additional settings allow you to put prompt text (Fig. 
10). After entering the sample text, it appears in front of the control itself (Fig. 11). After 
turning off Design Mode, this text appears only when the control is turned on for filling 
(Fig. 12).

Fig. 11. Forms

Fig. 12. Forms
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• For Combo Box Content Control, the advanced settings window allows you to enter 
drop-down list information (Fig. 13). Adding selectable options is done with the Add 
button in the Drop-Down List Properties tab. 

• With Date Picker Content Control, you can choose in what format to display the date 
(Fig. 14).

• The Option Button control is used to create radio buttons. Radio buttons are used when 
only one of the several options needs to be selected. You can see the window for setting 
the radio button in Fig. 15. The value to be selected is entered in the Caption field. 

Fig. 13. Forms   

Fig. 14. Forms
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Fig. 15. Forms
• The Check Box Content Control is used to add a checkbox. They are used when several 

of the many options need to be selected. The window in the advanced settings (Fig. 16) 
allows you to change the view of the fill squares and add a title. Checkbox values are 
entered before or after the control itself, as plain text. 

Fig. 16. Forms
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Form Protection
The idea of the forms is to be filled in by different people, without being able to edit the form. 

To protect your form from editing, you can change its settings. You must turn off Design Mode 
before enabling form protection. Restricting access is done from the Restrict Editing button in the 
Developer menu (Fig. 17). 

Fig. 17. Forms
After selecting this button, an additional settings menu opens, which you can see in Fig. 18. 

To limit the users to only be able to fill in the form is by ticking the second option and selecting 
an option from the drop-down menu.) In step 3 you must confirm your choice, after pressing the 
button, a new window opens. There you must enter a password to protect the document (Fig. 19). 

Fig. 18. Forms
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Fig. 19. Forms

Tasks:
1. In a text document, create a form that collects the following information:
• name - text input field
• family - text input field
• number - drop-down list with values from 1 to 10
• grade - drop-down list with values from 1 to 10
• gender - check button 
• optional module - radio buttons with values mathematics, English, information 

technology, German, and informatics
Save the file as form.
2. For the form you created in the first task, set security settings. The form can only be filled 

in, and for editing put a password - numbers from 1 to 9.
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26. pIvot tables

The summarization can be done:
• Statically – Subtotal
• Dynamically – Pivot Table
Pivot tables are dynamic tables that allow the user to summarize data in one or more fields 

and present it differently. They are used to compare and analyze huge amounts of data. Data can 
be sorted and filtered.

Creating a Pivot Table:
1. Select a cell from the table (list).
2. Select the Pivot Table button from the Insert menu, from the Tables panel (Fig. 1).

Fig. 1. Pivot
3. The Create Pivot Table dialog box opens (Fig. 2). The following must be determined:
• Data Source – if we are positioned in a cell of the table before inserting the Pivot Table, 

the entire table is automatically selected.
• Pivot Table location:

 ) On a new worksheet.
 ) On an existing (Existing Worksheet) with the ability to select a cell from which to 

display the Pivot table.
4. The structure of Pivot Table – Pivot Table Field opens (Fig. 3). There are two panels:
• A panel with the names of the columns from the original table (list).
• A panel with four sections to create a Pivot Table. The formation of the table is done by 

dragging the headers to the corresponding section using the mouse.
How do we determine where to place each header? – The data we put in Rows and Columns 

are interchangeable. We comply only with the Pivot Table itself – to be longer than wide. It is 
possible to place more than one header in Row and leave Column without. We put the calculated 
values in Values. The Sum function is automatically applied. 
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Fig. 2. Pivot

Fig. 3. Pivot
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Task 1: Open the Mileage-Car.xlsx file. Create a report showing the total mileage of each 
car and each shift with the ability to filter by date. (For each car, i.e. each registration number.)

It does not matter where the registration number and the shift are placed, i.e. in a row or in a 
column, they are interchangeable. Since there are two shifts and more cars and we are used to the 
table being longer than wide, we put the shift in a column and the registration number in a row. 
Placement is done by dragging the headers from the panel with the names to the Columns section 
and the Rows section, respectively.

With the possibility to filter by date => We put the date in Filter. In Values, we set the mileage. 
(Fig. 4 and Fig. 5 - graphically represented). The finished Pivot Table is presented in Fig. 6.

Fig. 4. Pivot

Fig. 5. Pivot
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Fig. 6. Pivot

Sort and filter data in the Pivot Table
Sorting and filtering in the Pivot Table are done in the same way as in a regular spreadsheet. 

In some headers there are arrows which give us a chance to sort or filter (Fig. 7).
Task 2: Using task 1, filter the data only from the first shift for the previous day. 
If we assume that today is 13.08.2021, then I will filter for the date 12.08.2021. From Column 

Labels, we choose the first shift. Fig. 7 shows the filtered table. The field on which it is filtered is 
changed from an arrow to a funnel.

Fig. 7. Pivot
Formatting data in the Pivot Table.
When working with Pivot Tables, an additional Pivot Table Tools menu opens with two 

submenus Analyze and Design. Formatting is performed from the Design menu (Fig.8).
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Fig. 8. Pivot

Fig. 9. Pivot

Tricks
If the data in the source table changes, the data in the pivot table does not change automatically. 

To update the data, select a cell from the table and the Refresh button from the Pivot Table Tools / 
Analyze menu, from the Data panel (Fig. 9). If more rows are added to the source table – Change 
Data Source (Fig. 9).

Tasks:
1. Open the Mileage-Car.xlsx file.
1.1. Prepare a report showing the total mileage of each car and each date with the possibility 

of filtering by shift.
1.2. Filter only for today.
1.3. Filter only for the second shift.
1.4. Filter for today's date and second shift.
1.5. Format the pivot table of your choice.
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27. preparatIon of referenCe - summary

One of the ways to prepare a report in MS Excel is through Summarization / Subtotals 
/ - Subtotal. The command provides the ability to automatically summarize the values of one or 
more fields for each value of another field, using a function – Sum, Min, Max, Average, Count and 
others. In order for the summary to be correct, the data needs to be sorted by the summary field. 

To implement the command, we must perform certain steps:
1. We sort the table according to a selected criterion against which the data will be 

summarized. 
2. We position ourselves in the field of the table.
3. Select Subtotal from the Data menu, from the Outline panel (Fig. 1).

Fig. 1. Subtotal 
The Subtotal dialog box opens (Fig. 2). In it we define:
• Summary field (At each change in) – select the column on which the intermediate 

calculations will be performed (the one on which the table is already sorted).
• Use function.
• Fields whose values will be summarized (Add subtotal to) – select the fields on which 

the selected function will be applied.
It is possible to summarize in more than one field and with several summary functions, for 

this purpose it is necessary to execute the Subtotal command several times, whereby the selection 
of the option Replace current subtotals must be canceled (otherwise the result of the second 
execution of Subtotal will replace that of the first).

Summary below data – there must be a check mark to see the intermediate calculations 
below the grouped rows, otherwise they are visible above the grouped rows.

Remove All – deletes the report, shows the table in its original form.

Fig. 2. Subtotal 
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Task 1: Open the Mileage.xlsx file. Prepare a report showing the minimum mileage for each 
car

1. Sort: by Registration Number (each car)
2. Select a cell from the table
3. Data / Subtotal (Fig. 2):
• We choose what we have already sorted – Registration number 
• Function Min
• Mark Mileage
Final version of the table (Fig. 3). The data are sorted by registration number. For each car 

(registration number), the minimum mileage is shown by adding a new line, and at the bottom is 
shown the grand summary (Grand Min). At the beginning of each of the added lines, there is a sign 
minus or plus respectively for hiding or showing of the detailed information.

Fig. 3. Subtotal 
Task 2: Open the Mileage.xlsx file. Prepare a report showing the maximum and average 

mileage for each car
1. Sort: by Registration Number (each car)
2. Select a cell from the table
3. Data / Subtotal (Fig. 2):
• We choose what we have already sorted – Registration number 
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• Function Max
• Mark the Mileage checkbox
Apart from the maximum, we also want the average mileage => We apply the Subtotal 

command once again, but this time we change the function to Average and uncheck Replace 
current subtotals.

Task 3: Open the Mileage.xlsx file. Prepare a report showing the total mileage for each car 
and the average mileage for each shift.

1. We sort:
• As the first criterion – Change (for each shift)
• As a second criterion – Registration number (for each car)
2. Select a cell from the table.
3. Data / Subtotal (Fig. 2):
• We choose the first one we have already sorted by - Shift
• Function Average
• Check the Mileage checkbox
We apply the subtotal command once again, as we do not forget to uncheck Replace 

current subtotals.
• We choose the second one we have already sorted by – Registration number 
• Function Sum
• Check the Mileage checkbox
Final version of the table (Fig. 4)

Fig. 4. Subtotal
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Tricks
If the rows were hidden before the data was aggregated, they participate in the calculation 

of the aggregated values.

Tasks:
• Open File NVO-10klas-Subtotal.xlsx 
• Make a report showing the average number of points for each school.
• Make a report showing the minimum and maximum number of points for each school.
• Prepare a report showing the minimum and average age of the students who appeared at 

the exam for each school.
• Make a report showing the average number of points in each subject and for each school.
• Make a report showing the average number of points in each subject and for each school.
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Project Development in a Team
Project carrying out organized activities to create a specific product that has a clear purpose 

and leads to specific results. The project can be individual or performed in a team.
• When forming a team, the individual capabilities and preferences of the participants 

must be considered and, depending on them, specific tasks must be assigned to each of 
the participants.

• The topic must be relevant, interesting, and applicable. In some cases, the topic is 
formulated by the contracting authority, and in others it is chosen by the team members. 
In school projects, the teacher is the assignor of the project.

• The purpose of the project must be clear and consistent with the objectives.
• In order to implement the specific activities in the process of project planning, a plan for 

the project work must be developed. The tasks are distributed and the deadlines for their 
implementation are determined. 

• Interim targets and deadlines need to be set and their implementation monitored.
• When working in a team, it is often necessary to share files, resources or to hold online 

meetings. Such an opportunity is provided by: Google Docs, Microsoft Office Online, 
Google Classroom, Microsoft Teams.

Project documentation
In parallel with the implementation of the project, begins the preparation of the documentation, 

which should contain the composition of the team and the distribution of roles in it, the topic and 
objectives of the project, the necessary resources and the work plan. The main groups of documents 
related to a working project are:

• Documents describing the project implementation process.
• Documents describing the created products.
• Documents describing the way the finished products work.

Integration of a project and presentation in front of an audience
Complete construction of the project - combining the results of specific activities in the 

project implementation.

Presentation of the project in front of an audience
A modern means of presenting ideas and products to the public is the computer presentation. 

In this case, the purpose of the project, the team that has implemented it, the activities performed as 
well as the materials used are described. For maximum impact on the audience when presenting a 
project, the most relevant information from it should be selected. This stage may include promoting 
the project in various ways, for example, through social networks.

 

28. work on projeCts

Iv. work on a projeCt
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In connection with the conduct of NEE 10th grade, an organization should be established 
for the conduct of the exam. Each student must be notified in advance of the date, school, and hall 
where he/she will take the exam.

• Form a team to perform the specified job.
• Select a team leader.
• Prepare a work plan and share individual tasks between team members.
• Set a time limit for the implementation of the project.
• The team leader can create a group on a social network so that communication between 

team members is easier and faster.
• Work in shared documents.
• The team leader must ensure the quality and timely performance of the individual tasks.
• The manager must keep documentation – describe the process of implementation of the 

project and the activities carried out by each team member.
• Each member of the team must comply with the time limit set.

I. With MS Excel, do the following:

1. Create a table that contains the following columns: District, Municipality, City, School, 
Principal, Incoming Number, Name, Middle name, Family name, PIN, BLL (Bulgarian 
language and Literature) School, Matt School, Foreign Language School, IT School (where 
the exam will take place), BLL Hall, Math Hall, Foreign Language Hall, IT Hall, Date 
BLL, Date Math, Date Foreign Language, Date IT, Access Code https://priem.mon.bg/. 

2. All exams start at 8:00am.
3. Enter participants’ info. 
4. In the Hall box, enter the data validity from 101 to 105, 201 – 205, 301 – 305.
5. In the Date field, create a choice between three dates.
6. In the Access Code field, the length of the text must be five characters.
7. In the PIN field, set the text length to 10 characters.
8. Sort data by County and School alphabetically.
9. Filter data for your school only.
10. Refer to how many students will take a foreign language exam and how many an IT one.

29. projeCt “natIonal external examInatIon – 
10th grade”
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II. Using the MS Word program, create a mail merge in the form of a business note to 
authenticate the place of attendance of NEE exams

Fig. 1. Project 1

III. Present the project to the class
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After conducting the NEE exams – 10th grade, the results of each student must be announced. 
• Form a team to carry out the given project.
• Choose a team leader.
• Set a deadline for project implementation.
• Prepare a work plan and distribute the individual tasks among the team members
• Let the team leader create a group on a social network so that communication between 

team members is easier and faster.
• Work in shared documents.
• The team leader must monitor the quality and timeliness of the individual tasks.
•  The manager must keep documentation describing the process of project implementation 

and activities carried out by each member of the team.
• Each member of the team must comply with the set deadline.

I. Perform the following actions with MS Excel
1. Create a spreadsheet that includes the following columns: District, Municipality, City, 

School, Director, Incoming number, Name, Surname, Family name, PIN, BLL /Bulgarian 
language and Literature/ points, Math points, Foreign language points, IT points, access 
code https://priem. mon.bg/ 

2. In the Incoming number field, the length of the text must be five characters.
3. Enter data about participants. 
– In the BLL points and Math points fields enter data validity in the range from 0 to 100.
– If the student has not appeared in the relevant Foreign language or IT exam, write “did not 

appear“.
4. In the access code field the length of the text should be five characters.
5. Sort the data by points by BLL.
6. Filter data only about your school.
7. Check how many students have appeared in a foreign language and how many in IT 

exam.

30. projeCt “natIonal external examInatIon – 
10th grade” – results
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II. With the program MS Word, create a form letter as a notification letter 
to certify students' results from the exams

Fig. 1. Project 2

III. Present the project to the class
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I. Make a comparative analysis of the lakes in Bulgaria
• Form a team to carry out the given project.
• Choose a team leader.
• Prepare a work plan and distribute the individual tasks among the team members.
• Set a deadline for project implementation.
• Let the team leader create a group on a social network so that communication between 

team members is easier and faster.
• Work in shared documents.
• The team leader must monitor the quality and timeliness of the individual tasks.
• The manager must keep documentation describing the process of project implementation 

and activities carried out by each member of the team.
• Each member of the team must comply with the set deadline.

II. Perform the following actions with MS Excel
1. Create a spreadsheet that includes the following columns: lake type, name, location, 

volume, area, altitude, depth.
2. Fill in the table.
3. Make a reference by finding the total area and the average volume for each type of lake.
4. Make a report as for each type of lake to find the maximum altitude and minimum area.

III. Using MS Word, create an advertising brochure on the Lakes in 
Bulgaria

IV. Via MS Power Point program, create a presentation about the lakes in 
Bulgaria

V. Present the project to the class

31. projeCt “lakes”



10th grade
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Information. Reliability of Information
The collection and spreading of information happen in many ways. Today one of the most 

commonly used sources of information is the Internet. There is a large amount of information 
on the network that is easily accessible and has multiple sources. With such a large amount of 
information and numerous sources, one of the main problems is the reliability of the information. 
Besides it, another problem in the network is the validity of the information.

Each search engine on the Internet offers additional settings to help search for information. 
Advanced Find allows you to search for information more precisely. Enables to set up the search 
engine to show you the most recent updated information. When searching for information on the 
Internet, it is important to make sure that it is up to date, you should check when it is published. 

Verification principles
When searching for information, you should consider the following:
• Use information only from trusted sources. Anyone can post information on the Internet, 

and if the source is not reliable, then there is no way to verify its reliability.
• Some websites have been created for a long time and the information in them has not 

been updated, which means that the information may be old and not true.

Ways to search for information 
When searching for information via a search engine, there are several ways for your search 

to be effective:
• "" - Quotation marks are used when searching for words that go together. The words that 

go together are placed in the quotation marks.
• * - The star replaces a word or phrase. 
• intitle: Search in titles only.
• intext: – Search only in a text.  
• ~ - Used when looking for synonym. It's put in front of the word whose synonym we're 

looking for.
• OR – Used between keywords or phrases. 

RSS
RSS (Really Simple Syndication) is a system that allows you to obtain information without 

visiting the page. The information is obtained by subscribing. Programs that allow this are called 
an RSS reader or an RSS aggregator. This software can be a web-based application or software 
used for the installation of a desktop machine.

Spam and Phishing
Spam is called any unwanted message that most often contains an ad, quote, suggestion, 

or virus. Such messages are most often distributed for commercial purposes and the sender is 
unknown. Opening such letters can lead to infecting the device with a virus or stealing personal 
data. 

Spam over Instant Messaging is a spam that is spread through real-time call programs.
Spit (Spam over Internet Telephone) is a spam that is distributed through an internet phone.
Phishing is a way to obtain important information by using e-mails or sites. 

1. assessment of the valIdIty and relIabIlIty of 
InformatIon

I. proCessIng of InformatIon and CommunICatIon



127

Cloud Technologies
Cloud technologies are multiple applications offered by service providers. To use the services 

offered, you must create an account. Cloud technologies provide the opportunity for digital 
cooperation for their users, giving them access to e-mail, file storage, the ability to share work on 
various documents, calendar, video channel, etc. The most well-known providers of these services 
are large companies like Google and Microsoft, which can support the necessary infrastructure for 
the delivery of such services. Access to such services may be free of charge or require a surcharge.

Google Digital Collaboration Tools
Google offers many tools that users can use to collaborate. Every user who has Gmail account 

gets access to a set of Google tools through it (Fig. 1) and also has storage space at Google Drive 
that is available from all devices with Internet access. 

Fig. 1. Digital Collaboration
Google Drive allows you to create a variety of documents to share with other users with the 

ability to collaborate (Fig. 2).

2. seleCtIon and use of modern teChnologICal 
means for dIgItal CollaboratIon
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Fig. 2. Digital Collaboration
The documents that can be created on the Google disk are tables or sheets, text documents, 

formulas, presentations, and more. In addition to documents, entire folders can be created and 
shared. Another means of collaboration offered by Google is Google Classroom (Fig. 3). 

Fig. 3. Digital Collaboration
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In this environment, users can create or join virtual classrooms (Fig. 4). 

Fig. 4. Digital Collaboration
They have the chance to place and evaluate tasks, publish materials, publish texts and allow 

each user to monitor their progress (Fig. 5). 

Fig. 5. Digital Collaboration
Google also enables its users to have real-time virtual encounters via the Meet app (Fig. 6). 

Fig. 6. Digital Collaboration
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The Home screen allows you to choose whether to join an existing appointment or create a 
new one (Fig. 7). 

Fig. 7. Digital Collaboration

When creating a new appointment, you can schedule a date and time to activate the link for 
it (Fig. 8). 

Fig. 8. Digital Collaboration

After starting the appointment, one can see a toolbar underneath. In the middle are the 
microphone control buttons, camera, hand-raising, enabling screen sharing and additional settings 
(Fig. 9). 
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Fig. 9. Digital Collaboration
On the right stand buttons allowing to see the users in the conversation, the chat of the 

meeting, the ability to turn on a recording and start a whiteboard. 

Microsoft Digital Collaboration Tools
Microsoft has developed its own digital collaboration tools.  All applications are collected in 

Office 365, which gives access to create spreadsheets, presentations, text documents and more. To 
start Office 365, you need to go to the initial page -  https://login.microsoftonline.com/   (Fig. 10) 
and login with an account and a password. 

Fig. 10. Digital Collaboration

Here you also have access to a virtual disk for storing information OneDrive and the online 
version of the Microsoft Office Suite applications like MS Word, MS Excel, and etc. (Fig. 11). 
Teams app allows you to create virtual classrooms and support real-time meetings (Fig.12).
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Fig. 10. Digital Collaboration 

Fig. 11. Digital Collaboration 
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1. Essence
1.1. Definitions
How to explain a complicated action to an executor who can do only simple ones? We should 

break up a complex action into small, simple steps, which an executer can do and this will lead to 
the desired result. 

Safety rules for crossing the street for example, must be known and pedestrians must comply 
with them. Obligation of every parent is to provide accurate and clear instructions about these rules 
to their child. This is usually done even in early age. To be clear for the toddler, the instructions 
must be given in sufficiently understandable and detailed steps. 

Rules for crossing the street: 
1. The street must be crossed at a pedestrian crossing.
2. Before crossing, we must stop on the pavement.
3. We must look to the left.
4. If there is not a car coming from the left, we look to the right.
5. If there is not a car coming from the right, we cross the street at the pedestrian crossing.

The simple action that the executer can do on his own is called an elementary action.
Any implementation of an elementary action is called a step. 
An algorithm is a system of instructions (commands), which sets elementary actions and 

the order of their execution to receive a certain outcome. 
The word algorithm is named after the Persian mathematician al-Khwarizmi, who lived in 

the 9th century. 
In 820, he wrote a scientific book about decimal numeral system, which was translated into 

Latin in the 12th century and led to the spreading of “computing art”.

1.2. Examples of algorithms 
Task 1: 
Let’s have the AB segment. Compile an algorithm for the construction of the midperpendicular 

of the segment AB. 
Solution: 
1. We construct a circle k (А, r>1/2AB).
2. Then we construct a circle k1 (В, r>1/2AB).
3. The next step is to construct intersection points S and S1 of the circles k and k1).
4. We construct the straight line SS1, which is a midperpendicular of the segment AB. 

3. algorIthms
II. Content CreatIon
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Task 2: 
The circle k (O, r) and the point M, which is outside the circle, are given. Compile an 

algorithm for the construction of tangents to the circle k, passing through the point M. 
Solution: 
1. We construct a circle k1 with a diameter of OM. 
2. The next step is to construct intersection points T and T1 of the circles k and k1.
3. Then we construct the straight lines g=MT and g1=MT1, which are the tangents to the 

circle k in point  M. 

Task 3: 
Compile an algorithm for the resolution of the square equation ax2+bx+c=0, where a≠0
Solution: 
1. Calculate D=b2-4ac.
2. Check the sign of D. If D<0, go to step 3.  Otherwise, calculate  and 

x1 and x2 are displayed.  Go to step 4.
3. Displays the message:  "The equation has no real roots".
4. End. 

When we have complex algorithms one and the same sequence of actions has to be described 
and executed several times.  This repetition can be avoided by separating this sequence into separate 
algorithm, called subalgorithm. 

Subalgorithm is a separate sequence of elementary actions, which can be used in the general 
algorithm repeatedly. 

2. Properties of algorithms
1. Discretion – each algorithm must consist of a finite number of elementary actions. 
2. Clearness – each current step must be exactly specified, and it must be explicitly defined 

which one is next. 
3. Formality – the executor can work formally and carry out the instructions, until he 

reaches the indication for end.  This property allows the executor of the algorithm to be 
an automatic device. 

4. Definiteness – it is when we use the same data to receive one and the same result. 
5. Mass character – implies that each algorithm is applied successfully to resolve the tasks 

of the same type for different input data.
6. Feasibility – to describe this property, we will look at the algorithm for finding the 7th 

simple number:
• Make a list of all natural numbers into increasing order.
• In the received list, cross out all numbers that are not simple.
• Bring out the 7th number as a result.
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It is obvious that the first and the second steps cannot be done by a man or a computer. This 
means that this algorithm does not solve the problem. It is not feasible.

7. Finiteness - an algorithm terminates after a finite numbers of steps.
8. Effectiveness - the algorithm must always give a definitive result for each value of the 

many acceptable inputs. 
9. Measuring effectiveness – when measuring the effectiveness of an algorithm the number 

of elementary actions (steps) and the input and interstitial data are very important. 
Defining of these two characteristics is very difficult even in the simplest cases.

It is not possible to define the line between effective and non-effective algorithms and how 
to measure it (in seconds, minutes, hours or days). It all depends on the certain problem and 
conditions.

3. Types of algorithms 
There are three types of algorithms according to the sequence of actions, which they perform. 
3.1. Linear algorithms 
Algorithms, in which actions are implemented sequentially in the order in which they are set 

are called linear. 

An example:
Task 4: 
Find the perimeter of a triangle with sides a, b and c. 
Input data: a, b and c, where а>0, b>0 and c>0.
Result:  P - the calculated perimeter.
Actions: Step 1: Start
Step 2: Input a
Step 3: Input b
Step 4: Input c
Step 5: P=a+b+c
Step 6: Output P
Step 7:  End. 

3.2. Branched algorithms 
In practice we are facing situations in which decision must be taken to implement one or 

another action.  Such situations are described by branched algorithms.  The branch allows you to 
select one of two options for the continuation of the calculation process. 

An algorithm, the implementation of which is divided into different sequences of actions 
depending on the truth of a given condition, is called branched. 
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An example 
Task 5: 
Compile an algorithm for the division of two numbers x and y. 
Input data: x,y; 
Result: z=x/y or the appropriate message. 
Actions: Step 1: Start
Step 2: Input x
Step 3: Input y
Step 4: If y=0 then  "Division is impossible"
Step 4.1 Go to step 6 
Step 5: z=x/y
Step 6: Output z
Step 7:  End. 

3.3. Cyclic algorithms 
Some of the actions often have to be executed repeatedly. When these repetitions must be 

executed one after another, this re-usable can be rationalised, using an algorithm for a cyclic 
(repetitive) process. 

Algorithms, in which a group of actions is implemented the necessary number of times, are 
called cyclical. 

An example 
Task 6: 
Find the sum of the numbers from 1 to 100. 
Input: The numbers from 1 to 100, which are consistently generated in number.
Result: S - the sum of the numbers. 
Actions: Step 1:  S=0 – sets an initial value of the sum. 
Step 2: number= 1 – sets the first number 1.
Step 3:  S=S+number – each subsequent number is being added to the amount.
Step 4: number=number+1 – generates the next in turn number.
Step 5: If the value of the next number (number) is less than or equal to 100, go to step 3.
Step 6: The S is being displayed.
Step 7: End. 

Apart from the sequence of actions algorithms can be classified by other characteristics too. 
For example, according to input data type algorithms are numerical, text, graphical, etc.
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In order to be developed, stored, and shared algorithms must be written down in a certain 
way. In informatics it is necessary to describe steps of the algorithm sequentially.  For this purpose, 
different descriptions are used, the most frequently used of which are: verbal, graphic and by a 
programming language. 

1. Verbal description 
In mathematics and other natural sciences lessons teachers often use verbal description to 

explain the method (algorithm) to resolve the tasks of a different type. This way of expressing 
algorithms is the easiest to be comprehended and is widely used. 

In this description, all steps of the algorithm are described consecutively in a natural language. 

Examples of verbal description are the solutions to tasks 4, 5 and 6 at the end of the previous 
lesson. 

2. Graphical description 
All steps of an algorithm are being set in a flowchart. 
Flowcharts consist of blocks and arrows that connect blocks.  The steps of the algorithm are 

described in blocks, connecting arrows indicate the sequence of implementation. 

2.1. Types of blocks 

4. desCrIptIon of algorIthms
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2.2 Basic algorithmic structures 

• Linear – actions are executed in the order in which they are set. 
• Branched – step-by-step structure, in which the calculation process is branched off 

according to the truth of a condition. 
• Cyclic – an action, or group of actions are repeated multiple times depending on the truth 

of a given condition. 

The cyclic structure contains four basic components: 
1. Initialization – sets the initial value of one or more control variables of the cycle. 
2. Body of the cycle – contains actions that are repeated multiple times. 
3. Update – preparation for the next execution of the body of the cycle. 
4. Condition that provides the end of the cycle – logical expression whose value is “true” 

or “false”.  The truthfulness of the condition is being checked and depending on its value 
the cycle is terminated or continues its action with the implementation of cyclic part.  
The condition for end must ensure termination of repetitive action.  If it is not well done, 
implementation can reach to the process of loop, i.e. endless repetition of the body of 
the cycle. 

• Cycle with a pre-condition – the condition for end is set and checked before body of the 
cycle.  Repetitive actions are implemented, while the condition is true. 

• Cycle with after-condition – the condition of end is set and checked after the body of 
the cycle.  In the language C++ repetitive actions shall be executed until the condition is 
true, and in Pascal – until the condition is false. 
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2.3 Basic requirements for the flowchart creating. 
• Each block diagram must have exactly one “start” and at least one “end”. 
• Except for the block for start, to any other block of the scheme, there must be a path from 

the beginning.  Also, from each block there must be a path leading to the end. 
• Blocks, describing cyclic structures, must not allow “endless loop”. 

 ) Common mistakes
There are two start blocksWe do not reach to the End following the “yes” arrow of the 

conditional blockEndless loop – the value of the I does not change anywhere in the body of the 
cycle
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4. By programming language 
A program that solves the given task is created by some programming language. 
An example 
Task 1:  Find the surface of the circle with radius R. Display an appropriate message 

considering that the entered value of radius is not a positive number. 

Verbal description 
Input:  R. 
Result:  S or the appropriate message
Actions:     Step 1:  Set value for R. 
Step 2: If R<=0 displays the message:  “Incorrect data” and go to step 5.
Step 3:  Calculate S=3.14 * R2.
Step 4:  The S is being displayed. 
Step 5:  End. 

By programming language

A graphic description
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Google form
Google Forms is a platform for online form creation. The advantage of electronic forms is 

the easier way of filling in, collecting, and summarizing the information. 
There are several ways to create a Google form:
1. In Google Drive (Fig. 1).

Fig. 1. GForms
2. open Google form directly (Fig. 2).

Fig. 2. GForms

5. onlIne forms and quIzzes
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With a blank Google form, only one question is initially loaded (Fig. 3). 

Fig. 3. GForms
At the top of the form are tools for working with it. In the left corner is the name of the form, 

and you can change it by double-clicking (Fig. 4). 

Fig. 4. GForms
The center has two options for switching from questions to answers (Fig. 5). 

Fig. 5. GForms
In the right corner there are controls for setting up a Google form (Fig. 6):   

Fig. 6. GForms
• Add-ons to the Google form.
• Change the color/theme of the Google form.
• Preview form (shows how the filler will see it).
• Google form settings.
• Submit.
• Additional settings.
• Adding questions 
• Possible types of questions are:
• question requiring a free answer – short or paragraph.
• questions with optional radio button answers.
• questions with optional checkbox button answers.
• a question with a possible choice from a drop-down list.
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• Scale.
• Table.
• to enter a date or time.
• Adding a question is done from the plus sign next to the highlighted question (Fig. 7). 

From there, the following is added:
• import a question from another form.
• an explanatory text and a title.
• add an image.
• add a video. 
• add a new section.

Fig. 7. GForms
Form settings
When you select the settings button at the top of a document (Fig. 6), a new window opens 

with three menus (Fig. 8).

Fig. 8. GForms
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This window sets a limit on who can fill it in, how many times they can fill it in, whether 
they can edit it after sending. It can be chosen whether the questions come out sequentially or to 
be shuffled for each user. The last menu allows you to set the form to be a test and the collected 
answers can be evaluated.

Sending the form
The Send button (Fig. 6) opens a new window that provides three possible options for 

sending the Google form (Fig. 9):
• sending by email.
• Sending via a link (there is a possibility of a secret link).
• embedding in html code.

Fig. 9. GForms
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Microsoft Office 365 form
Microsoft Office 365 also provides an opportunity online form creation. To create a MS 

Office 365 form, you should log in to your account at office.com and then My Apps – Forms  
(Fig. 10)

Fig. 10. MSForms
From there you have two options – to create a quiz or a form to collect data. (Fig. 11)

Fig. 11. MSForms
There are no initially loaded questions, and you need to add them by the “+Add new” button 

(Fig. 12). 

Fig. 12. MSForms
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Possible types of questions are as in the Google form (Fig. 13 and Fig. 14).

Fig. 13. MSForms
The center has two options for switching from questions to responses.

Fig. 14. MSForms

At the top of the form are tools for working with it. By using the three dots icon you can 
access settings of the form (Fig. 15 and Fig. 16). 
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Fig. 15. MSForms

Fig. 16. MSForms
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With the “Theme” button you can choose different themes for your form (Fig. 17).

Fig. 17. MSForms

Sharing the form
The Share button (Fig. 18) opens a new window that provides different possible options for 

sending the form (Fig. 18):
• sending by email.
• Sending via a link (there is a possibility of a secret link).
• embedding in html code.
From there, you also can choose who can respond to you form (Fig. 19).

Fig. 18. MSForms
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Fig. 19. MSForms

Tasks:
1. Create a Google form with the following questions:
• name – Short text.
• class – drop-down list with values from 8 to 12.
• number – multiple choice with values from 1 to 5.
• studied subjects – table (in columns it contains FUCH, IUCH and ZUCH, and in rows 

– Mathematics, Bulgarian language, Information technologies, English, and German 
language).

• how well you speak English - a linear scale starting with 1 for bad command and going 
up to 5 for very good command.

Customize the theme of your choice and save the finished form named sample.
2. Send the created form from task 1 to three of your classmates:
• via a link.
• by email.
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Macros
Macros are a set of instructions that are grouped into a common command and execute 

automatically at startup. When a macro is created, it remembers the actions performed with the 
mouse and the pressed keys, after saving it as a command and running it, it follows the same order 
of executed commands. After creating a macro, it can be changed. The actions in the macro are 
performed in the order in which they are written. 

Microsoft office offers the creation of macros in its products. The applications have built-in 
functions that allow macro recording, and you can also use the program editor in Visual Basic for 
application (VBA).

Create a macro in Microsoft Word 
In Microsoft Word Text Editor macro is created from the Developer menu by clicking on the 

Record Macro button (Fig. 1). 

Fig. 1. Macros
The location from which the macro is created is from the View menu and from the Macros 

drop-down menu, select Record Macro (Fig. 2).

Fig. 2. Macros
After selecting the Record Macro command, a new window opens in which you should 

specify the name of the created macro and select whether to apply it only in the current document 
or in all of them (Fig. 3).

6. maCros
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Fig. 3. Macros
In the Description field, you can enter a short description of the commands that the macro 

will execute. There are two ways to start the macro. They are selected from the same window in 
the Assign macro to tab:

• Using a button.
When selecting the option to start with a button, an additional settings window opens (Fig. 4). 

Fig. 4. Macros
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To create a macro and start it with a button, from the menu that opens you need to add the 
macro to the toolbar (Fig. 5).

Fig. 5. Macros
The Modify button allows you to customize the icon of your macro, this button opens a new 

window in which you can select the icon (Fig. 6).

Fig. 6. Macros
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After selecting an icon and pressing the OK button on the main window (Fig. 5), the macro 
recording starts. After performing the actions, you want to record in your macro, you must select 
the Stop Record button (Fig. 7).

Fig. 7. Macros

After recording, you can see the button that appears in the toolbar and launches your macro 
(Fig. 8).

Fig. 8. Macros

When you select this button, the actions you have saved are performed automatically in the 
document (Fig. 9). 

Fig. 9. Macros
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• Using a Key Combination
Selecting the option to start with a keyboard shortcut opens an additional settings window 

(Fig. 10). 

Fig. 10. Macros
The only difference is that here the macro is started with a keyboard shortcut that you have 

chosen instead of a button (Fig. 11). 

Fig. 11. Macros
After entering the keyboard shortcut, click on Assign and then on Close, followed by Record 

the macro and to finish the Stop Record button.
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Edit created macros
If you want to view or edit already created macros, you must open the Macro window, which 

shows all created macros (Fig. 12). 

Fig. 12. Macros
From here you can view, delete, modify and run all created macros. You can open the Macros 

window from two places:
from the Developer menu and the Macros button (Fig. 13).

Fig. 13. Macros

from the View menu and the View Macros button (Fig. 14).

Fig. 14. Macros
Tasks:
1. Create a macro to start with Ctrl + T. The macro must insert a table 3x5 in the text 

document. 
2. Create a macro that can be launched from a button. The macro must insert a 6x9 table in 
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the text document.
Task:
Use your knowledge of a form document and template selection to create certificates for 

your computer science competition. You must first select a suitable template (Fig. 1).

Fig. 1. Certificates

The information about the participants that must be included in the certificate for each student 
is shown in the table in Fig. 2.

Fig. 2. Certificates

7. form letter – CertIfICate
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The next steps are like those for creating a form letter. You put the necessary information in 
the right place and then generate the ready-made certificates (Fig. 3).

Fig. 3. Certificates
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Task
In previous lessons, you have learned how to create a circular document and select a suitable 

template. Use this knowledge to prepare the business cards of Izgrev real estate agency. You must 
first select a suitable template (Fig. 1). 

Fig. 1

The information about the employees of the company, which should be included in the 
business card of each one, is shown in the table in Fig. 2.  

Fig. 2 

8. form letter – Create a busIness Card



160

Once you have selected the appropriate template, you need to make the field size settings. 
Exemplary dimensions can be found in Fig. 3.

Fig. 3

In order to be able to set the exact dimensions from the menu Mailings, select the button 
Start Mail Merge and the option Labels (Fig.  4). 

Fig. 4
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After selecting the dimensions, dotted fields with that size appear on your template. Using the 
mouse, you can move and place them more precisely on the business cards you will create (Fig. 5). 

Fig. 5
The next steps are similar to those for creating a Form letter. Put the necessary information 

in the right place and then generate the finished business cards.
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Basic types of problems
The modern world is increasingly tied to digital technologies. We use computers in most of 

our daily lives, thus facing various technical problems: hardware and software.
The most common hardware problems:
• CPU problems.
• memory problems.
• video card problems.
• problems with peripherals.
• problems with network devices.
• reduced performance of the computer system.
• Most common software problems:
• operating system problems.
• problems related to the operation of a specific program.
Task 1: Check what operating system you are using and search the internet for its minimum 

and recommended requirements.

Device Manager
The easiest way to manage the devices on your computer is through the built-in Windows 

device management module called Device Manager. 
It shows the devices installed on the computer and the 
resources allocated to them. With it you can: 

• view what devices are installed on your 
computer and change hardware settings.

• stop certain devices.
• remove, change, or update installed drivers for 

a device.
• turn off, turn on, and uninstall devices.
• to troubleshoot problems with devices.
You must be logged on as an administrator to use 

most features in Device Manager.

There are several ways to start Device Manager 
(Fig. 1):

• the Start / Windows System / Control Panel 
menu.

• Right-click on the Start menu and select Device 
Manager.

• click on the Start menu, then select Run ... and 
in the dialog that will appear type “devmgmt.
msc”.

9. troubleshootIng and safety

III. troubleshootIng and safety

Fig. 1. Problems 
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• Right-click on My Computer / Manage / Device Manager.
• Right-click on My Computer / Manage / Device Manager.
• click on the Start menu and select Settings/Device.
• type the following command at the command prompt (click on the Start/Run – cmd 

menu): start devmgmt.msc.
Depending on where you start it from, the window may or may not be divided into two parts.  

To see the characteristics of a device, select the device type and then select the specific device  
(or right-click Properties). A dialog box opens (Fig. 2):

• The General section (Fig. 2) contains general information about the device. The Device 
status field describes the status of the device. For a normally functioning device, the 
status in the Device status field must be: “This device is working properly”. If there is 
a problem, an error code is displayed. More information can be obtained by entering the 
code in a search engine (Google).

• The Driver tab (Fig. 3) contains information about the drivers of the selected device 
(Driver Details), Update, Disable, Uninstall.

Task 2: View the hardware devices on your computer and their settings (via Device Manager).
Task 3: Uninstall a hardware device from your computer.
• Start Device Manager - right-click on the Start menu and select Device Manager (Fig. 1).
• Select the device you want to uninstall and in the Driver section select Uninstall Device. 

Dialog box opens (Fig. 4).
On some devices, the computer needs to be restarted to perform the uninstall process.

Fig. 2. Problems  Fig. 3. Problems  
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Fig. 4. Problems  

Hardware Problems Solution

Problems caused by hardware failure Removing damaged components

Removing external media from the device 
during operation – USB, CD / DVD, etc. Restart the operating system

General electrical interference Hardware checking and / or restarting the 
operating system

Installing a new device (RAM, HDD, etc.) 
incomparable with the hardware

Hardware checking. Remove the device 
causing the error.

In case of touchpad problems   
Settings-> Devices-> see if it is not turned 
off by software or to reinstall / update the 
touchpad drivers. 

In case of a mouse problem

For example, a wireless mouse that freezes 
may require a change of the battery, while 
a wired mouse that freezes may need to be 
repaired or replaced.

In case of problems with the WiFi network

check that the network card drivers are 
updated to the latest version. This is done in 
Control Panel> Device Manager> Network 
Adapters

In case of camcorder problems Check the camcorder drivers in Control 
Panel> Device Manager> Imaging Devices.
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Task Manager
Task Manager is a popular Windows tool used to monitor and manage running processes and 

services. Task Manager can be used for various purposes: 
forced shutdown of processes, checking the consumption of hardware resources by a process, 

monitoring the use of resources for the system as a whole, enabling or disabling startup programs, 
etc.

Starting Task Manager:
• by right-clicking on the Start menu and selecting Task Manager.
• by right-clicking on the taskbar and selecting Task Manager.
• With a keyboard shortcut from Ctrl + Alt + Del and selecting the Task Manager option.
• with the keyboard shortcut Ctrl + Shift + Esc.
A dialog box opens (Fig. 5). When selecting More details, a window of Fig. 6 appears:
• The Processes section (Fig. 6) shows all opened programs (Apps) and all processes 

currently running on the computer (Background processes, Windows processes). Provides 
information about the system resources consumed by each process - processor, RAM, 
disk, network, graphics processor, etc. By left-clicking on the title bar of a column, you 
can sort the processes in ascending or descending order. For example, if your system 
is too slow, you can check that an application (process) consumes more resources than 
normal, or sort at the top the processes that consume the most system memory, processor, 
etc. From here you can forcibly stop a process. This is done with the End Task button or 
the Delete key. This step is used in case a program is blocked and does not want to close 
in the usual way.

• In the Performance section (Fig. 7) you can see the total capacity of the system and what 
part of the resources (processor, hard disk, memory, network, graphics processor) are 
currently used.

• App history tab – Shows a history of how many resources are used by the current user 
account.

• Start-up tab – Shows all applications that start with Windows when you log on. 

Task Manager is used to close a program that is not working properly or has been blocked. 
But when closed, data that is not saved is lost.

Fig. 5. Problems
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Fig. 6. Problems

Fig. 7. Problems
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Task 4: Open the Task Manager on your computer and view CPU, memory, and network 
traffic.

Task 5: Use Task Manager to stop a program that you have started.
• Open the task manager - by right-clicking on the Start menu and selecting Task Manager.
• In the Processes tab, select the desired program.
• Select the End Task button.
Lack of sufficient free disk space on the system partition.
The operating system needs some free disk space on the main partition where it is installed to 

function properly. Reducing it below the critical size slows down the system and generates a Low 
Disk Space error. In this case, you need to clean the system partition.

Task 6: Open This PC (for Windows 10) and determine the system partition of the device. 
Right-click on it, select the Properties option, then the Disk Cleanup button. In the next window, 
click the Clean up system files button. Wait for the operation to complete. Comment on the 
bookmarks that can be selected when opening individual windows.

Questions and tasks:
1. What are the main hardware and software problems that occur when using a computer?
2. How to uninstall a hardware device?
3. How does a task manager terminate a program?
4. Check the hardware device drivers on your computer: update with a new version, 

uninstall.
5. Suggest solutions to the following problems:
6. When working with a specific program, it does not work properly.
7. A specific hardware device is not working properly on your computer. 
8. When a flash drive is inserted, it does not appear in the list of disks.

Curious:
If you work on a network, network security settings may restrict access to some features in 

Device Manager.

Software problems Solution
Internal to the operating system Reinstall the operating system

Caused by a program Restart and uninstall a program

Caused by a conflict between the 
driver and the operating system Driver update

Caused by lack of resources 
(RAM)

Stopping redundant programs and 
processes

Minimize all programs with one 
click

You have to press Microsoft button 
+ D at the same time and so all 
programs will be minimized.
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Task 1:  The Alphabet Book Exchange prepares a daily report on the books sold. For this 
purpose, fill in the table in the sheet “Alphabet” from the file Sales.xlsx (Fig.1):

Fig. 1. Exercise
• The numbers are filled with consecutive numbers.
• Enter at least 10 titles of books and their authors, including Bulgarian and foreign authors. 

Enter a cover price.
• The origin must be selected from a drop-down list (Data / Data Validation).
• The discounted price depends on the origin of the book. In case the book is Bulgarian, it 

is calculated according to the formula:
Cover price * (1 – Discount for Bulgarian authors)
If the book is foreign, then the discounted price is calculated by the formula:
Cover price * (1 – Discount for foreign authors)
The percentage of the discount for Bulgarian and foreign authors is in boxes I2 and I3, 

respectively.
• Enter the available and requested quantity.
• The residue is calculated by the formula:
Quantity available - Requested quantity
• In cell I5, use the appropriate function to display the current date.
1. Develop the table from the sheet “alphabet”. The values in the columns cover price, 

discounted price to be displayed with two characters after the decimal separator. Present the values 
in the columns available and requested quantity and the remainder as an integer.

2. Copy the Alphabet sheet and name it Summary. In it, display the average amount of 
the available and ordered quantity. Summarize the data by origin and, within the origin, by cover 
price. Show only summary rows.

Directions: First we sort, then we summarize by what we have already sorted. The sort 
order matches the summary order.

3. Add a new sheet named Advanced Filter. Generate a reference for books of foreign origin 
and with a balance of less than 10 and more than 100 copies.

10. solvIng praCtICal and theoretICal 
problems through data analysIs (exerCIse)
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Directions: When the criteria are located on one line they are connected with the logical 
"and", and when they are on different lines – with “or”.

4. Add a new sheet named Pivot. Create a Pivot Table that displays the total cover price, the 
discounted price and the minimum quantity ordered by origin and title. Numeric values should be 
displayed with two characters after the decimal separator.

5. With Pivot graphics in a new sheet called "diagram" present the rest of the books by 
origin - Bulgarian and foreign.

Questions and tasks:
1. Create a list of your class. It must include class number, name, average grade from the 

past school year, scholarship. As it is in the column Scholarship ‘yes’ or ‘no’ will be 
written depending on the entered value of average success. If it is over 5.5 write ‘yes’, 
otherwise – ‘no’.

2. Prepare a report for the students who will receive a scholarship. The report can be 
prepared in three ways: via Subtotal, Filter and Pivot.

3. With the Pivot chart in a new sheet called a “chart” present the ratio between students 
who take a scholarship and those who do not.

4. With the Pivot chart in a new sheet called a “chart 1” present the percentage ratio between 
students who take a scholarship and those who do not.
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Let's remember - Data analysis with MS Excel includes:
• Sorting - arranging data from a specific column in the desired sequence.
• Filtering - provides the ability to see only part of the data that meets certain conditions 

(criteria) pre-set by the user, and the rest of the data is temporarily hidden.
• Preparing reports.
• Summary - provides the ability to automatically summarize the values of one or more 

fields for each value of another field, using the function - Sum, Min, Max, Average, 
Count and others. For the summarization to be correct, the data must be sorted by the 
summarization field and the summarization must be performed on the same field.

• Comparison, calculations, etc.
The analysis can be performed using Pivot Tables. Pivot tables are dynamic tables that 

allow the user to summarize data in one or more fields and present it differently. They are used to 
compare and analyze huge amounts of data. Data can be sorted and filtered. Data cannot be entered 
or modified in the summary table. If changes are required, they are made in the data source table.

Task 1: Create a pivot table to illustrate how many kcal, protein, fat and carbohydrates are 
contained in 100 g of a product. The products should be divided into categories. Use the Health.
xlsx spreadsheet. 

Creating a Pivot Table:
1. Select a cell from the table (list).
2. Select the Pivot Table button from the Insert menu, from the Tables panel (Fig. 1).

Fig. 1. Analiz
3. The Create Pivot Table dialog box opens (Fig. 2). The following must be determined:
• Data source - If we are positioned in a cell of the table before inserting the Pivot Table, 

the whole table is automatically marked, otherwise - we select the whole table.
• Pivot Table location:

 ) On a new worksheet.
 ) On an existing worksheet with the ability to select a cell from which to display the 

Pivot table.
4. The structure of Pivot Table - Pivot Table Field opens (Fig. 3).  There are two panels:
• Panel with names of the headers from the original table (list).
• A panel with four sections to create a Pivot Table. The formation of the table is done by 

11. data analysIs and data proCessIng wIth 
ms exCel
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dragging with the mouse the headers to the corresponding section. 
How do we determine where to place each header? - The data we put in Rows and Columns 

are interchangeable. We comply only with the Pivot Table itself – to be longer than wide. It is 
possible to place more than one header in Row and not in Column. We put the calculated values in 
Values.  The Sum function is automatically applied. 

Fig. 2. Analiz

Fig. 3. Analiz
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Graphically Pivot Table is presented in Fig. 4. and the completed table in FIG. 5. As the table 
is very large, it is good to present the information by categories (choosing the minus sign in front 
of each category).

Fig. 4. Analiz

Fig. 5. Analiz
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It is possible to change the summary function. From the drop-down list of the field selected 
in the Values area, select Value Field Settings ... (Fig. 6) and the Value Field Settings dialog box 
opens (Fig. 7).  In the Custom Name field, the name itself is preceded by Sum of, which can be 
replaced with an appropriate title.

Update data in the Pivot Table
When working with Pivot Tables, an additional Pivot Table Tools menu opens with two 

submenus Analyze and Design (Fig. 9).
When you change the data in the base table, the data in the summary table does not change 

automatically. To update the data, select a cell from the Pivot Table and the Refresh button from 
the Pivot Table Tools / Analyze menu from the Data panel (Fig. 8). If more rows are added to the 
main table to be reflected in the Pivot Table, Change Data Source is selected (Fig. 8).

Fig. 8. Analiz

Fig. 6. Analiz Fig. 7. Analiz
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Task 2: Using the already created Pivot Table from Task 1:
• Enable filtering by product category - move product category from Rows field to Filters 

field.
• Analyze data for fruit category - by filtering (from the arrow in the header All).
• Analyze dairy category data - kcal, fats and carbohydrates - We remove proteins from 

field Values by dragging.
• Sort alphabetically (from the arrow in the Row Labels header).
• Change the category of dairy products to eggs - the change is made in the main table and 

follows update (Refresh).
• Add information about dairy products. It is in the same file on page More. (The information 

is copied and updated via Change Data Source).

Pivot Table Design
The Pivot Table is formatted from the Pivot Table Styles panel of the Design menu of the 

additionally open Pivot Table Tools menu (Fig. 9).

Fig. 9. Analiz
Additional settings of the Pivot Table are set from the layout panel of the Design menu (Fig. 10):
• Visualization of partial summaries of the data by groups (Subtotal button) - whether to 

have them, whether to be above or below the respective group.
• Final summaries of data by rows and columns (Grand Totals).
• Preview of the summary table view (Report Layout).

Fig. 10. Analiz
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Creating a Pivot Chart
1. Select a cell from the summary table.
2. Selecting the Pivot Chart button from the Analyze menu (Pivot Table Tools menu) 

from the Tools panel (Fig. 11) opens the Insert Chart dialog box. Select the desired chart 
type.

 Fig. 11. Analiz

Task 3: Create a pivot diagram using the pivot table from problem 2.1. Filter to view data 
for fish and seafood category only (Fig. 12)

Fig. 12. Analiz

Questions and Tasks:
1. Open the file Min_Wage.xlsx and create a summary table (Fig. 13), which will display 

the minimum wage by country and year and allow filtering by continent.
2. Sort countries alphabetically.
3. Directions: Germany is at the top - The available spaces before the first character are also 

considered when sorting – they must be deleted.
4. Add information about five more countries. It is in the same file on page More. Update 

Pivot Table.
5. Format the table.
6. Filter by continent.
7. Create a pivot diagram to visualize the average minimum wage by continent and year 

(Fig. 14).
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Fig. 13. Analiz

Fig. 14. Analiz
 



177

1. Electronic identity
A person's identity is a set of characteristics that allows them to be unambiguously identified 

and distinguished from others. The identity of a person is certified by the state. There are different 
procedures in different countries, but when a person is born they receive a birth certificate in which 
their names are entered, an individual number (not always) and these data are entered in a common 
database. On this basis, various identification documents are issued – ID card, passport, driver's 
license and more.

Why is this important? In today's civilized world, it is especially important to be able to 
distinguish one person from another. The driver's license, for example, certifies that we have just 
taken the exam and know how to drive a car. The notary deed certifies that the owner of a property 
is Ivan Ivanov, and the ID card certifies that this is exactly Ivan Ivanov – the owner of the property. 

In order to travel, for example, we also need identification to prove that we have the right to 
travel in the respective country. 

Other examples may be the fight against crime, taking a bank loan, starting a job and more.
Our “offline” identity is important, but so is our “online identity” – a way to prove who you 

are on the Internet. When a person performs legally significant actions, or when communicating 
with the state in order to obtain services, data or certificates, the service provider must be able to 
prove whom he is “dealing” with. Here comes the “electronic identification” process, which was 
recently defined in an EU regulation, and which in most cases means owning an issued by the state 
hardware that only the owner knows how to “unlock”.

Like anything, identity can be stolen or falsified, and this is called “identity theft”.
An example is the use of somebody else’s identity document. In other cases, someone can 

forge an identity document by making it contain what they need, which can lead to very bad 
consequences for unsuspecting citizens. However, governments and experts are trying to fight 
against this problem. 

2. Electronic signature
An electronic signature is a requisite of an electronic document intended for its protection 

against forgery. It is issued by a certification body and contains the name of the holder, serial 
number, date of validity and a copy of the public key. Electronic signatures can be verified in special 
registers. Electronic signatures are used in the distribution of software, in financial transactions and 
everywhere else where important information is exchanged electronically. This is very important 
in order to detect in time any falsification or attempted falsification.

A qualified electronic signature has the meaning of a handwritten signature. It ensures the 
authenticity of the signed electronic documents. The signed document remains signed regardless 
of whether you store it on magnetic, optical or other media, whether you send it by e-mail or access 
it via the Internet. 

The affixing of an electronic signature means that:
• you identify yourself as the author of an electronic document.
• you agree with the contents of the document.
• the document is protected from subsequent changes.

12. teChnICal and organIzatIonal seCurIty 
when workIng In a dIgItal envIronment
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“Qualified electronic signature” means an advanced electronic signature which is created 
by a qualified electronic signature creation device and which is based on a qualified certificate for 
electronic signatures.

“Qualified electronic signature certificate” means an electronic signature certificate issued 
by a qualified certification service provider.

The certificate for qualified electronic signature contains information about the signatory  
(a Holder) and the legal entity with which it is associated, such as:

• Names (of a company or an organization).
• PIN (or personal number of a foreigner).
• Unique Identification Code - UIC (The holder is associated with a legal entity).
• Address.
• Other data.

3. Biometric data
Biometrics combines methods for uniquely recognizing people based on their inherent 

physical or behavioral traits. In information technology, biometrics is used to identify people as an 
access control. It is also used to identify individuals in groups that are under surveillance.

Biometric characteristics can be divided into two main groups:
• Physiological characteristics are related to the shape of the body. Examples of this are 

fingerprints, facial shape recognition, DNA, palm geometry, iris recognition (which 
largely replaces retinal scanning).

• Behavioral – these are characteristics related to human behavior. Examples of these are 
voice recognition, writing rhythm and gait.

The voice is strictly part of the physiological characteristics because each person has 
a different voice system, but voice recognition is based on the way a person speaks, which is 
classified as a behavioral characteristic.

• A feature can be used as biometric if it meets the following conditions:
• Versatility – each person has a given characteristic.
• Uniqueness – how well a characteristic separates individuals.
• Persistence – measures how well a given biometric characteristic behaves over time 

(whether there are changes with the aging of the individual, etc.).
• Collectability – how easy it is to measure.
• Workability – accuracy, speed and durability of the technology used.
• Acceptability – the extent to which the technology used is accepted.
Biometric systems operate in the following two modes:
• Verification – direct verification of whether the collected biometric data correspond 

to a template to determine whether the individual is the one for whom they present 
themselves. It is used in conjunction with a card, identification code or username 
(possibly a combination).

• Identification – compares the data collected for compliance in a database of biometric 
data to establish the identity of an unknown individual. The identification is performed 
when a complete match is found in the database.
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 The rapid development of the Internet and digital technologies (DT) in the 21st century 
has ushered in a new era in communication and access to information in modern society. Electronic 
devices in all their diversity – computers, tablets, laptops, smartphones, TVs, Playstations, etc., 
have become an integral part of our daily lives.

The intensification of digitalization has led to the formation of new concepts such as “digital 
worldview”, “digital environment”, “digital friendships”, which are very often present only in our 
“digital world”. New professions such as influencers, bloggers and others have emerged directly 
related to the development of social networks and digital technologies.

The state of emergency imposed in Bulgaria in March 2020 as a result of the Covid-19 
pandemic strengthened digital dependence in conditions of social isolation. Compulsory distance 
learning for children in Bulgaria and forced work from home, the so-called “Home office” for their 
parents, will be more and more present after the end of the pandemic and the return of life to its 
normal course. However, the negative physiological and psychological effects of excessive screen 
exposure will inevitably affect the human body.

As good sides from the rapid development of technologies we can mention:
1. Better medicine - with advances in healthcare, pharmacology and molecular biology, we 

live longer. Modern medicine has effectively doubled the average life expectancy of a 
person for a little over a century.

2. Technical gadgets are improving health and fitness – with the development of the health 
technology revolution, it has become easier for people to access their health indicators 
using various smart devices. Fitness bands, smart watches and sensors and technologies 
with medical applications such as blood sugar monitors, health technologies are now 
widely accepted by many people who want to take personal responsibility for their 
health. For example, using a smart scale connected to an application allows you to track 
your weight loss goals and progress.

On the other hand, the damage is not small either.
1. Smartphones cause “musculoskeletal problems” – with the increased use of smartphones, 

tablets and laptops, more and more people visit their doctors with complaints of the 
musculoskeletal system.

2. Sleep deprivation and screen tension – there is evidence that our daily 'screen time' has 
many negative effects on our mental health, causing sleep disturbances, headaches and 
mood problems, including generalized anxiety disorder and depression. Looking at the 
screen for too long can exhaust our eyesight, blur our vision and dry our eyes. You may 
also experience tension in your head as another result of digital eye strain.

3. Sedentary lifestyle and mental health – when we are at home, we rarely have to move 
further from the TV to the bed. With the spread of mobile technology, there is already 
an application for everything. In addition to the obvious problems associated with a 
sedentary lifestyle, such as obesity and diabetes due to poor diet and lack of exercise, 
the effect of mental health should also be considered. It has never been easier to connect 
with someone, anywhere, at any time – but is the experience the same as a face-to-face 
conversation?

13. the ImpaCt of the use of dIgItal 
teChnologIes on health and the envIronment



180

The negative effect of technology on the environment affects every living thing. Animals 
that are more vulnerable fall under this weight. Although there are other factors that contribute to 
the extinction of some different species, technology also plays a very important role.

Information and communication technologies (ICT) can be a favorable factor for the 
environment. ICTs are increasingly being used to address environmental challenges such as 
climate change. ICT systems achieve more sustainable consumption and production. They have 
the potential to influence consumer choice and behavior – less travel, remote work; change in 
driving style; rational use of energy through “smart technologies”.

On the other hand, the increasing use of ICTs leads to an increase in the energy used and thus 
they have a direct impact on the environment in terms of energy use, durability of materials and 
treatment of equipment after the end of its life.
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